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Welcome to your printer
Your printer is a color inkjet printer designed for high-productivity print speed in monochrome and color. Some 
major features:

● Print up to 30 D/A1 pages/min.

● Deliver mixed monochrome and color sets with a consolidated workflow.

● Start printing faster with an ultra-fast processor, plus native PDF management or HP SmartStream 
software.

● Free up the operator when using accessories such as the production stacker, online folder, up to six rolls, 
and dual ink supplies with auto-switch.

● Print GIS map and point-of-sale (POS) poster applications at breakthrough speeds.

● Set a technical document standard with crisp lines, fine detail, and smooth grayscales.

● HP PageWide XL pigment ink for dark blacks, vivid colors, and moisture/fade resistance, even on uncoated 
bond paper.

● Print on a wide range of papers up to 40 in (101.6 cm) wide, covering ISO/US technical and offset 
standards.

● Low cost of operation in monochrome and color versus LED, with long-life printheads and high ink 
efficiency.

● Reduce downtime with cloud-based support, self-monitoring, proactive alerts, and automatic maintenance.

Safety precautions
Before using your printer, read, understand, and follow these safety precautions, and your local Environmental, 
Health, and Safety regulations, to make sure you can use the equipment safely.

You are expected to have the appropriate technical training and experience necessary to be aware of hazards to 
which you may be exposed in performing a task, and take appropriate measures to minimize the risks to yourself 
and to other people.

General safety guidelines
● There are no operator-serviceable parts inside the printer except those covered by HP's Customer Self 

Repair program (see http://www.hp.com/go/selfrepair/). Refer servicing of other parts to qualified service 
personnel.

● Turn off the printer and call your service representative in any of the following cases:

– The power cord or plug is damaged.

– The drying enclosures are damaged (Asia-Pacific and Japan only).

– The printer has been damaged by an impact.

– There is any mechanical or enclosure damage.

– Liquid has entered the printer.
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– There is smoke or an unusual smell coming from the printer.

– The printer has been dropped.

– The drying module has been damaged (Asia-Pacific and Japan only).

– The printer is not operating normally.

● Turn off the printer in either of the following cases:

– During a thunderstorm

– During a power failure

● Take special care with zones marked with warning labels.

Electrical shock hazard

WARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous voltages 
capable of causing death or serious personal injury.

WARNING! The internal circuits of the drying system (Asia-Pacific and Japan only) operate at hazardous 
voltages capable of causing death or serious personal injury.

The printer uses one power cord. Unplug the power cord before servicing the printer.

To avoid the risk of electric shock:

● The printer must be connected to earthed mains outlets only.

● Do not attempt to dismantle the drying modules (Asia-Pacific and Japan only).

● Do not remove or open any other closed system covers or plugs.

● Do not insert objects through slots in the printer.

● Take care not to trip over the cables when walking behind the printer.

Heat hazard (Asia-Pacific and Japan only)
The printer’s drying subsystem operates at high temperatures and can cause burns if touched. To avoid personal 
injury, take the following precautions:

● Let the printer cool down before accessing the paper output area in case of a paper jam.

● Let the printer cool down before performing some maintenance operations.

Fire hazard
The internal parts of the printer’s drying subsystem (Asia-Pacific and Japan only) operate at high temperatures.
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To avoid the risk of fire, take the following precautions:

● The customer is responsible for meeting the printer's requirements and the Electrical Code requirements 
according to the local jurisdiction of the country where the equipment is installed. Use the power supply 
voltage specified on the nameplate.

● Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not use the 
power cord with other products.

● Do not insert objects through slots in the printer.

● Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before using 
the printer again.

● Do not use aerosol products that contain flammable gases inside or around the printer. Do not operate the 
printer in an explosive atmosphere.

● Do not block or cover the openings of the printer.

● Do not attempt to dismantle or modify the drying modules (Asia-Pacific and Japan only).

Mechanical hazard
The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions 
when working close to the printer:

● Keep your clothing and all parts of your body away from the printer's moving parts.

● Avoid wearing necklaces, bracelets, and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the printer.

● Take care that sleeves or gloves do not get caught in the printer's moving parts.

● Do not operate the printer with covers bypassed.

● Do not try to dismantle the cutter assembly: refer servicing to qualified service personnel.

● Do not stand on the drawers: the printer could fall over.

Light radiation hazard
Light radiation is emitted from the beacon, ink level indicators, paper drawer indicators, and formatter status 
indicators. The emitted light is in compliance with the requirements of the exempt group of IEC 62471:2006, 
Photobiological safety of lamps and lamp systems. Do not modify these modules.

Heavy paper hazard
Special care must be taken to avoid personal injury when handling heavy rolls of paper.

● Handling heavy rolls may require more than one person. Care must be taken to avoid back strain and/or 
injury.

● Consider using a forklift, pallet truck, or other handling equipment.
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● When handling heavy rolls, wear personal protective equipment including boots and gloves.

● Do not exceed the maximum weight of a paper roll: see Functional specifications on page 140.

Paper rolls could weigh up to 18 kg. Follow your local Environmental Health and Safety recommendations for 
handling heavy paper rolls.

Ink handling
HP recommends that you wear gloves when handling the ink maintenance cartridge or waste container.

Warnings and cautions 
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer 
from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or 
death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or 
damage to the printer.

Warning labels  

Label Explanation

Electric shock hazard. Heating modules operate at hazardous 
voltages. Disconnect power cord before servicing.

CAUTION: Double pole. Neutral fusing.

Before starting, read and follow the operating and safety 
instructions.

Crush hazard. Keep hands away from the moving service carriage.

This label is located by the access to the service carriage, on the gas 
springs, and in the folder.

You are recommended to wear gloves when handling the cleaning 
container.

This label is located on the cleaning container and by the access to 
the service carriage.
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Label Explanation

Do not use the drawers as stairs: the printer could overbalance.

This label is located on the drawers.

Do not touch the starwheels: they are fragile.

This label is located on each side of the output area.

Risk of trapped fingers. Do not touch the rollers.

This label is located on the high-capacity stacker.

Risk of trapped fingers. Do not touch the gears while they are 
moving.

This label is located on the high-capacity stacker.

NOTE: The final label position and its size on the printer may vary slightly, but labels should always be visible 
and close to the potential risk area.
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Main components 
The following front and rear views of the printer illustrate the main components.

Front view

1. Print bar

2. Front panel

3. Ink cartridges

4. Paper access front cover

5. Drawer

6. Maintenance cartridge

Rear view

1. Output module

2. Paper output

3. Power switch and plug
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4. LAN connections

5. Cleaning container

Front panel
The front panel is a touch-sensitive screen with a graphical user interface, located on the front right of the 
printer. It can rotate 360 degrees horizontally, so you can use it from the front or rear of the printer. It can also be 
tilted to minimize reflections.

It gives you complete control of your printer: from the front panel, you can view information about the printer, 
change printer settings, monitor printer status, and perform tasks such as supplies replacement and 
calibrations. The front panel displays alerts (warning and error messages) when necessary.

It includes the following components:

1. A Hi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be printed or 
a destination for scanned files. When a USB flash drive is inserted, a USB icon  is displayed on the 

front panel's home screen.

2. The front panel itself: an 8 inch, full-color, touch-sensitive screen with a graphical user interface.

3. A loudspeaker.

4. The Power key, with which you can turn the printer on or off, or wake up from sleep mode. The key is 
illuminated when the printer is on. It flashes when the printer is in sleep mode.

5. The beacon, which enables you to see printer status and alerts from a distance.

The front panel has a large central area to display dynamic information and icons. On the left and right sides you 
can see up to four fixed icons at different times. Normally they are not all displayed at the same time.

Left and right fixed icons

● Tap  to return to the home screen.

● Tap  to view help about the current screen.
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● Tap  to go back to the previous screen. This does not discard any changes made in the current screen.

● Tap  to cancel the current process.

Home screens

There are three top-level screens that you can move between by sliding your finger across the screen, or tapping 
the appropriate button at the bottom of the screen:

● The first main screen provides direct access to the important printer functions, depending on your printer 
model and accessories.

Non-MFP screen

● The all-app screen displays a list of all apps available in your printer, and the status of each of them.

● The widget screen enables you to monitor at a glance supplies such as ink and paper, the job currently 
being printed, and the job queue.
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Printer alerts
The printer has a beacon located on top of the front panel; it gives a summary of the printer status that can be 
seen from a distance.

IMPORTANT: The information provided in the beacon is for functional information purposes only, and is not 
relevant to your safety. Warning labels on the printer must be always considered when operating the printer, 
regardless of the status indicated by the beacon lights.

White light The printer is ready.

White moving light The printer is printing or preparing to print.

Yellow end light
The printer will need attention soon: for example, it is almost out of ink or 
paper. When printing, the yellow light remains at the left, and a white 
moving light appears.

Yellow light
The printer can print, but there is something wrong. If the problem persists, 
contact your support representative. While printing, you will see a yellow 
instead of a white light.

Red light The printer is unable to print and needs attention, or a major subsystem of 
the printer is not working.

You can change the beacon settings by tapping  , then System > Beacon. For example, you can change the 

brightness of the beacon. You can also turn off beacon warnings and show only definite errors.
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Dim mode
After some time with no activity (5 minutes by default), the printer goes to dim mode, which reduces the 
brightness of the front panel by 25% and the brightness of the beacon by 10%. Any activity, such as the use of 
the front panel or the arrival of a print job, ends dim mode and restores normal brightness. After some time in 
dim mode (15 minutes by default), the printer changes to sleep mode. The time periods can be changed from 
the front panel. See Sleep mode on page 11.

Sleep mode
Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some elements to 
save energy. Printer features can be enabled from this mode, and the printer maintains network connectivity, 
waking up only as necessary.

The printer can be woken from sleep mode in any of the following ways:

● By pressing the power button

● By opening a door or drawer

● By sending a print job

● By installing or uninstalling the high-capacity stacker

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep mode, the 
power button blinks.

To change the time that elapses before sleep mode, see Change system options on page 11.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Utility and Web 
JetAdmin continue to be available during sleep mode. Some remote management tasks offer the option of 
remotely waking up the printer if needed to perform the task.

Change the language of the front-panel display 
There are two possible ways to change the language of the front-panel menus and messages:

● If you can understand the current front-panel display language, tap  , then System > Language .

● If you cannot understand the current front-panel display language, start with the printer powered off. Press 
the power key to turn it on. When you see icons appear on the front panel, tap  and then  . The 
front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display. Tap 
your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish, 
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.
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Change system options

You can change various printer system options from the front panel. Tap  , then System.

● Date and time options to view or set the printer's date and time.

● Speaker volume to change the volume of the printer's loudspeaker. Select Off, Low, or High.

● Front panel brightness to change the brightness of the front-panel display. The default brightness is 50.

● Beacon > Beacon to change the brightness of the beacon. Select High, Medium, Low, or Off.

● Beacon > Notify warning alerts to turn warning alerts on or off.

● Power options > Printer sleep to change the length of time the printer waits before going into sleep mode 
(see Sleep mode on page 11). You can set the time from 5 to 240 minutes. The default time is 20 minutes 
(total time including 5 minutes in dim mode).

● Unit selection to change the units of measurement in the front-panel display. Select English or Metric. By 
default, units are set to Metric.

● Restore factory settings to restore the printer settings to their original values as set in the factory. This 
option restores all of the printer settings except the Gigabit Ethernet settings and paper presets.

HP Utility
The HP Utility enables you to manage your printer from a computer with a TCP/IP connection.

NOTE: The HP Utility under Mac OS X and the HP DesignJet Utility under Windows have similar functions and 
are sometimes referred to collectively as the HP Utility in this guide.

● Under Windows, start the HP DesignJet Utility from the  icon on your taskbar or from Start > All 
Programs > HP > HP DesignJet Utility > HP DesignJet Utility. This launches the HP DesignJet Utility, showing 
the printers installed on your computer. When you open the HP DesignJet Utility for the first time, it may 
offer you an automatic update with enhanced functionality that we recommend you to accept.

● Under Mac OS X, launch the HP Utility from your Dock shortcut or by clicking Applications > HP > HP Utility. 
This launches the HP Utility, showing the printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that 
printer.
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Embedded Web Server
The Embedded Web Server is a Web server running inside the printer. You can use it to obtain printer 
information, manage settings and presets, install new firmware, and troubleshoot problems. Service engineers 
can use it to retrieve internal information that helps to diagnose printer problems.

You can access the Embedded Web Server remotely by using an ordinary Web browser running on any computer.

The following browsers are known to be compatible with the Embedded Web Server:

● Microsoft Internet Explorer 8 and later for Windows 7 and later

● Apple Safari 6 and later for OS X 10.8 and later

● Mozilla Firefox 36 and later

● Google Chrome 41 and later

Make a note of your printer's IP address, which you can see on the front panel by tapping the  icon, then 

Network.

To use the Embedded Web Server on any computer, open your Web browser and enter the printer's IP address in 
the browser's address bar.

The Embedded Web Server window displays five separate tabs. A button near the top of each page provides 
access to online help.

The Embedded Web Server functions in the following languages: English, Portuguese, Spanish, Catalan, French, 
Dutch, Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. It uses the 
language that you specified in your Web browser options. If you specify a language that it cannot support, it 
functions in English.
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To change the language, change your Web browser's language setting. For example, in Chrome, click Settings > 
Language (in the advanced settings view), and make sure that the language you want is at the top of the list in 
the dialog box; or, in Internet Explorer version 8, go to the Tools menu and click Internet Options > Languages. 
Make sure that the language you want is at the top of the list in the dialog box.

To complete the change, close and reopen your Web browser.

Turn the printer on and off
If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use the 
power key on the front panel.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are 
recommended to turn it off using the power switch at the rear.

To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about 3 minutes to initialize and check and prepare the print bar. 
Preparing the print bar takes about 75 seconds. However, if the printer has been off for 2 weeks or more, 
preparing the print bar could take up to 7 minutes, plus 13 minutes if it needs a printhead recovery.

See also Sleep mode on page 11.

Internal prints
The internal prints give various kinds of information about your printer. They can be requested from the front 
panel.

Before requesting any internal print, check that the printer and the paper are ready for printing.
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● The loaded paper should be at least A3 landscape—420 mm (16.53 in) wide—otherwise the print may be 
clipped.

● The front panel should be displaying the Ready message.

To print any internal print, tap  , then scroll down to Internal prints and tap it, then select the internal print 

you want. The following internal prints are available:

● Demo prints show some of the capabilities of the printer

– Print drawing demo

– Print rendering demo

– Print GIS map

● User information prints

– Usage report shows estimates of the total number of prints, number of prints by paper type, number 
of prints by print-quality option, counting of scans, and total amount of ink used per color (the 
accuracy of these estimates is not guaranteed)

– HP-GL/2 palette shows the color or grayscale definitions in the currently selected color palette

– PostScript font list shows PostScript fonts available (PostScript printers only)

– Print folder pattern

● Service information prints

– Print current information

– Print usage information

– Print event logs

– Print calibration status

– Print connectivity configuration

– Print all pages (prints all the above reports)

● Output destination prints

– Print test on folder to check alignment

– Print test on stacker to test alignment

Preparing your printer

Connect the printer to your network
The printer is able to configure itself automatically for most networks, in a similar way to any computer in the 
same network. The first time you connect it to a network, this process may take a few minutes.

ENWW Preparing your printer 15



Once the printer has a working network configuration, you can check its network address from the front panel: 

tap  .

TIP: Consider making a note of the printer’s network name and IP address, because you may need them during 
the setup process of connecting your Windows or Mac OS computer clients.

Modify network configuration

To modify the current network configuration, go to the front panel and tap  , then  , then Gigabit 

Ethernet. From here it is possible, though not normally necessary, to change the settings manually; this can also 
be done remotely using the Embedded Web Server.

For full details of the available connectivity settings, see Networking on page 72.

If you accidentally misconfigure the printer’s network settings, you can restore the network settings to their 

factory values from the front panel: tap  , then  , then  , then Restore factory settings. Then you 

must restart the printer. This automatically provides a working network configuration for most networks. The 
printer’s other settings remain unchanged.

Connect a computer to the printer by network (Windows)
The following instructions apply if you intend to print from software applications using a printer driver. See 
Sending a job to print on page 82 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your network 
on page 15).

Now you can proceed to install the printer software and connect to your printer.
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Printer software installation

1. Make a note of the printer’s host name and IP address from the front panel (see Embedded Web Server 
on page 13).

2. Download the printer software from HP's website at http://www.hp.com/go/pagewidexlseries/support/
drivers.

3. Select Windows or Mac OS X software, and choose which specific software you want to install (by default, 
all of it).

4. Once downloaded, open it, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps 
you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order 
to find the printer. You also have the options of searching for the printer by its hostname, IP address or MAC 
address.

Uninstall the printer software (Windows)
Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Connect a computer to the printer by network (Mac OS X)
You can connect your printer to a network under Mac OS X by using the following methods:

● Bonjour

● TCP/IP

NOTE: The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See 
Sending a job to print on page 82 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your network 
on page 15).

Now you can proceed to install the printer software and connect to your printer.

1. Go to the front panel and tap  . Note the mDNS service name of your printer.

2. Access the install package from HP's website: http://www.hp.com/go/pagewidexlseries/support/drivers. If 
prompted, select your printer from the list.

3. When the PageWide Printer window appears on your screen, click Software and drivers.

4. Select Windows or Mac OS X software, and choose which specific software you want to install (by default, 
all of it).

5. When the software has been installed, the HP Utility starts automatically, to set up a connection to your 
printer. Follow the instructions on your screen.
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6. In the Setup Assistant screen, look for your printer's mDNS service name (which you noted in step 1) in the 
Printer Name column.

● If you find the right name, scroll sideways if necessary to see the Connection Type column, and check 
that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

● If you cannot find your printer's name just click Continue and do the setup manually in your System 
Preferences later on.

Click Continue.

7. Continue following the instructions on the screen.

Uninstall the printer software (Mac OS X)
During the previous installation step, you have the option to install the HP Uninstaller application in your system. 
This should be available under HP in the system Applications folder.

IMPORTANT: The HP Uninstaller application will uninstall all HP Software installed in your system.

To delete the print queue only, select the Print & Scan dialog from the system preferences. Click the name of the 
printer and then click the – button.

Configure your connectivity
By configuring your connectivity, you can print from your local network, keep your printer up to date, and access 
additional printer services. Remember to connect your network cable to the printer.

Accept the connectivity agreement and settings in order to:

● Receive automatic firmware updates

● Participate in the Customer Involvement Program

● Enable additional printer services

A network connection is required, so the printer will test its own connectivity. Configure and troubleshoot the 
printer’s connectivity and start benefitting from connecting your printer.

If you are part of the HP Partner Link Pay-per-use service, remember to go to the Connectivity app and tap 
Printer services > Register new service in order to register the printer service.

During initial printer setup, you are asked whether you want to enable these services. That decision can be reset 

later by tapping  , then Connectivity > Reset Connectivity Agreement.

In addition, each service can be enabled or disabled individually as explained below.

Verify printer connection to HP

You can check that the printer is able to connect to HP services by tapping  , then  , and verifying the 

status there.
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If there is any problem connecting to HP, you will be provided with a description of the problem and some 
possible solutions.

Configure the Customer Involvement Program and other printer services

You can check your Customer Involvement Program status by tapping  , then  .

Tap Test all connectivity to test your connection to HP, the Customer Involvement Program, and other online print 
services. If any problem is detected, you will be provided with a description of the problem and some possible 
solutions.

Configure email printing through HP Connected

The HP Connected service makes it easy to send jobs to your printer by attaching them to an email message.

You must accept the “Connectivity agreement” in order to use HP Connected. You can change your decision by 

tapping  , then Connectivity > Reset Connectivity Agreement.

To configure the email printing configuration, tap  , then  , which will display your printer’s unique 

printer code and the email address that can be used to send jobs to the printer. You must also visit 
http://www.hpconnected.com to register yourself and your printer (using the printer code).

Tap  in the top right corner of the HP Connected screen to access the following options:

● HP Connected Connectivity menu: You can enable or disable HP Connected for this printer, or completely 
remove it from the HP Connected service.

● Printer code: You can view or renew the printer code.

● Email address: You can view the printer’s email address.

● HP Connected jobs: You can decide whether jobs received by email should be printed directly (the default 
option) or put on hold in the job queue.

● Restore HP Connected settings: You can restore HP Connected settings to their default values.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download firmware 
updates.
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NOTE: If an administrator password has been set, it will be required to change these settings.

● In the Embedded Web Server: click Setup > Firmware update.

● Using the front panel: tap  , then  , then  .

The following settings are available:

● Check: If you select Automatically (the default setting), the printer will check automatically every week (or 
after the printer has been restarted seven times, whichever happens first) whether new firmware is 
available. If you select Manually, the printer will not check automatically; you can check manually whenever 
you like.

● Download: If you select Automatically (the default setting), the printer will automatically download new 
firmware whenever it becomes available. If you select Manually, you will be asked to approve each 
download.

NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install the 
new firmware, you must confirm the installation manually.

● Firmware update history: A list of firmware versions that have been installed in the printer. It is usually 
possible to reinstall the version immediately before the version that is currently installed, if you have some 
problem with the current version.

Configure the email server
To configure the email server using the Embedded Web Server, click Setup > E-mail server, and fill in the 
following fields, which are usually supplied by the email server provider.

● SMTP server and port number: The IP address or fully qualified domain name of the outgoing mail server 
(SMTP) that will process all email messages from the printer. If the mail server requires authentication, 
email notifications will not work.

● Printer e-mail address: The email address assigned to the account that is being configured in the printer. 
This email address will appear in the From: field of all the email messages sent by the printer. This is not 
the same email address that is used by HP Connected.

● Attachment size limit: The maximum size of a file attached to an email message. When you scan to email 
from the front panel, you will be warned if an attachment is higher than this limit, but you can ignore the 
warning and send the message anyway.

● Use SSL certificates: Check this box to use SSL certificates if the server requires an encrypted connection. 
Click the link to configure advanced certificate settings.

● Authentication. If you choose authentication, you are also asked for your username and password.

Once you have configured the email server, you are strongly recommended to check the configuration.

Turn usage information on and off
The printer can send usage information periodically by email. You can request this in the following ways:

● In the HP DesignJet Utility for Windows: from the Admin tab, click Printer settings > Accounting.

● In the HP Utility for Mac OS X: click Printer Settings > Accounting.

● In the Embedded Web Server: click Setup > Printer settings > Accounting.
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In each case, you must set the following options:

● Send accounting files: Enabled (the default is Disabled)

● Send accounting files to: a valid email address

● Send accounting files every: choose a number of days (1–60) or a number of prints (1–500)

You must also ensure that the email server has been configured: see Configure the email server on page 20.

Turn email notifications on and off
In order to receive email notifications from the printer, you must have configured the email server (see Configure 
the email server on page 20).

The notification service is always turned on, but all specific notifications are turned off by default. You can turn 
them on or off individually by selecting Notifications from the Setup tab of the Embedded Web Server.

Control access to the printer 

Front-panel security settings

From the front panel, you can tap  , then Security, to control some of the features of the printer:

● USB drive: Enable or disable the use of a USB flash drive.

● Firmware update from USB: Enable or disable firmware updates from a USB flash drive.

● User sessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.

● EWS: Enable or disable the Embedded Web Server.

● Printer access control: Enable, disable, or change the administrator password.

● Printing & management Web services: Enable or disable Web services that are used by printing and 
management tools such as the HP Utility, HP SmartStream, and SDK for RIPs.

If an administrator password has been set, it must be given in order to perform the following operations:

● Change the security settings (including the administrator password itself)

● Change the configuration of the Internet connection

● Change the Automatic Firmware Update configuration

● Enable or disable automatic downloading and/or installation of automatic firmware updates

● Restore an earlier firmware version

● Reset factory defaults

NOTE: The administrator password can contain only characters that appear on the front panel's on-screen 
keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not appear 
in that limited character set.
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Embedded Web Server security settings

From the Embedded Web Server, you can click the Setup tab and then Security to change the security settings:

● Securely erase some or all files on the hard disk

● Enable or disable various groups of front panel operations

● Use the same security settings that are available in the front panel (see above)

NOTE: An administrator password may be required.

NOTE: For more information, see the Embedded Web Server's online help.

To control access to the printer’s front panel from the Embedded Web Server, go the Setup tab, and click Security.

The following options are available:

● Unlock: Unrestricted access to the front panel.

● Minimum Lock: Unrestricted access to the front panel.

● Moderate Lock: In addition to the Minimum Lock, denies access to all printer settings, the job queue, 
information and service prints, and the printer log.

● Intermediate Lock: In addition to the Moderate Lock, denies access to the paper, ink supplies, maintenance 
options, and demo prints. Users can only view printer and supply information.

● Maximum Lock: Denies access to all front-panel options. No detailed information is displayed in any of the 
status applications.

When any option is restricted, the option is locked and marked with a padlock icon.

Embedded Web Server access control

From the Embedded Web Server, you can click the Setup tab and then Access control to change the access 
control settings.
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To use these access control settings, the security settings should permit unrestricted access to the front panel 
(Unlock). See Embedded Web Server security settings on page 21.

Access control categories

● Sign-in methods: Manage the methods that can be used to sign in to the printer.

● Device user accounts: Create, edit, or delete printer user accounts.

● Sign-in and permission policies: Manage sign-in requirements for specific tasks, restricting user access by 
type of activity.

Sign-in methods

Currently, the only available sign-in method is Local device, referring to local accounts that have access codes 
between 4 and 8 digits long, stored on the printer’s hard disk.

Device user accounts

There are four available actions:

● New: Add a new user account.

● Edit: Edit the selected user account.

● Delete: Delete the selected user account.

● Delete all: Delete all user accounts.

When you click New, the following window opens, in which you must fill in at least the name and the email 
address.

You can change the user access code, and the permission set, as follows:

● Admin user: The admin user has all access privileges granted and cannot be edited.

● Device user: The device user has some access privileges granted, which can be edited on the access control 
page.

● Guest user: The guest user has some access privileges granted, which can be edited on the access control 
page.

Click Apply to add the new user, who is then displayed as shown below.
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Sign-in and permissions policies

You can change the permissions for device and guest users here, and click Apply to apply them.

NOTE: To use some functions, you must be able to use the higher-level function: for example, Print from USB 
requires Print.

NOTE: All users have at least guest permissions.

NOTE: The Firmware Update function means, in this context, automatic firmware updates. To block firmware 
updates from a USB flash drive, you must use a specific setting that affects all users.

When a user tries to use any blocked function for the first time, the following window appears, in which the user 
should give the appropriate password. To give the admin password, click the three dots in the upper right corner.
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Require account ID
If you want to keep records of printer usage by different user accounts, you can set your printer to require an 
account ID for each job.

● In the HP DesignJet Utility for Windows: from the Admin tab, click Printer settings > Accounting > Require 
account ID.

● In the HP Utility for Mac OS X: click Printer Settings > Accounting > Require account ID.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on hold 
for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting" by 
the printer, you can introduce the account ID in the Embedded Web Server, HP DesignJet Utility, HP Utility, or front 
panel, by going to the job queue and clicking the job that is on hold. A window with a text box is displayed and 
you can enter the account ID into it.

Drivers
There are various different drivers for your printer; which is best for you depends on your circumstances:

● Your operating system

● The type of applications from which you print

● The number of printers you have

● The output accessories you have

You may wish to install one or several drivers according to your needs.

You can find the latest driver software at http://www.hp.com/go/pagewidexlseries/support/drivers/.
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Specific Windows drivers

This printer will be managed with several drivers, each driver is optimized for specific 
circumstances as: 
 

• Operating system. See specific for Windows (+link) or specific for Mac (+link) 
• Type of applications you print from 
• Number of HP Designjet printers supported (only one, fleet). See UPD if you have a fleet 

(+link) 
• Output accessories you have connected 

 
Considering these aspects, it will be necessary to install one or several drivers depending on your 
needs. 
 
Specific Windows drivers for HP Page Wide XL 
 

  
HP-GL/2 PCL3GUI v4 PostScript PostScript v4 PDF v4 

Application 

CAD, GIS, office 
applications 

Recommended Recommended 
      

Applications requiring 
accurate color     

Recommended Recommended 
  

Adobe Acrobat or 
Adobe InDesign         

Recommended 

System 

Windows 7   n/a   n/a n/a 

Windows 8 or later           

Desktop           

Modern app n/a   n/a     

 
 
You can find last Windows drivers available at  http://www.hp.com/go/PageWideXL/drivers.  
 
Universal Windows driver for fleet of HP Designjet printers and Page wide 
XL series printers 

• Use this extended driver If managing a fleet of HP PageWide printers and other LFP printers.  
• Universal windows driver version facilitate the installation and queue management of fleet 

in your network.  
• Within this driver you will have the HP-GL/2 Driver and PostScript Driver options. 

 
You can find last Windows drivers available at  http://www.hp.com/go/PageWideXL/drivers. 
 
Mac drivers for HP Page Wide XL   
 
HP Page wide XL series Mac Raster driver  

• Raster driver for HP PageWide XL. 
• Specific for MAC OSX 10.8, 10.9 and 10.10 
• Best for CAD, GIS and general Office applications. 

 
 

Universal Windows driver

The Universal Windows driver is recommended if you have a fleet of HP DesignJet and PageWide XL printers: it 
facilitates installation and queue management. The driver includes HP-GL/2 and PostScript options.

Universal Windows driver configuration tool

The Universal Windows driver configuration tool is a utility to create VDF files, with which you can personalize 
DesignJet and PageWide XL Universal Printer Drivers (UPDs) by modifying the default settings or locking some of 
them, preventing users from changing them. This tool is intended for IT administrators, allowing them to set or 
lock the color, rotation, and quality options of the driver for different user roles.

To install the tool, go to http://www.hp.com/go/pagewidexlseries/support/. If prompted, select your printer from 
the list.

In the Software and Drivers section, click Software > Utility > UPD configuration tool > Download. For information 
about how to install and use it, go to https://support.hp.com/us-en/document/c05658213.

Mac OS drivers

Raster driver

● Specifically for Mac OS X 10.8, 10.9, and 10.10

● Best for CAD, GIS, and office applications

PostScript 3 driver

● Specifically for Mac OS X 10.8, 10.9, and 10.10

● Best for applications requiring accurate color

In addition to http://www.hp.com/go/pagewidexlseries/support/drivers/, Mac OS drivers are available through 
Apple Software update.

26 Chapter 1   Introduction ENWW

http://www.hp.com/go/pagewidexlseries/support/
https://support.hp.com/us-en/document/c05658213
http://www.hp.com/go/pagewidexlseries/support/drivers/


Set Windows driver preferences 
You can change some default settings in your printer driver according to your own preferences, for instance to 
set color emulation or paper-saving options. To do this, click the Start button on your computer's screen, then 
click Devices and Settings. In the Devices and Settings window, right-click your printer's icon, and click Printing 
Preferences. Any settings you change in the Printing Preferences window will be saved as default values for the 
current user.

To set the default values for all users of your system, right-click the printer’s icon, click Printer Properties, go to 
the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will be saved for all 
users.

Accessibility

Front panel
If required, the front-panel display brightness and the loudspeaker volume can be changed (see Change system 
options on page 11).

Embedded Web Server
From the Embedded Web Server, you can see the status of the printer, and perform other actions without using 
the front panel.

For information about the accessibility features of the Embedded Web Server, go to: Support > Browse 
information > Accessibility:

See more about HP accessibility at www.hp.com/hpinfo/abouthp/accessibility/ for information about the HP 
Accessibility Program, and HP's commitment to making its products and services accessible to people with 
disabilities.
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Other sources of information
The following documents can be downloaded from http://www.hp.com/go/pagewidexlseries/support/manuals/:

● Introductory information

● User’s guide

● Legal information

● Limited warranty

The Quick Response (QR) code images found in some parts of this guide provide links to additional video 
explanations of particular topics.
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2 Paper handling

● General information and tips 

● Supported paper types 

● Paper status 

● Load paper 

● Unload paper 

● Paper options 

● Store paper 

● Cannot load paper 

● Protect a paper type 

● Paper jam 
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General information and tips
● All paper widths must be between 279 mm (11 in) and 1016 mm (40 in), and the roll core must be 76 mm 

(3 in) in diameter.

● When handling photo paper, wear cotton gloves to avoid transferring oils onto the paper.

● Each drawer can be loaded with two paper rolls (front and rear).

Your printer has up to three drawers: the second and third may be purchased as accessories. The roll 
positions are numbered 1 and 2 in the top drawer, 3 and 4 in the middle drawer, 5 and 6 in the bottom 
drawer.

The roll numbers are displayed on the front of each drawer and on the roll hubs.

● Each drawer has lights to communicate its status:

Drawer roll icon light

– Off: The roll has paper, or there is no roll.

– On (yellow): The roll is running out of paper.
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– On (red): The roll is out of paper.

Drawer lock light

–  Off: You can open the drawer.

–  On: Do not open the drawer. The paper is moving and you could cause a paper jam.

● You can save paper by using the appropriate settings.

● The printer automatically estimates the remaining length of the roll.

Supported paper types
The following paper types are compatible with your printer.

Supported HP papers

Name Width Length Product number

Plain paper

HP Universal Bond Paper, 3-in core 16.5 in (420 mm) 500 ft (152 m) K6B85A

18 in (457 mm) 500 ft (152 m) M2N04A

23.4 in (594 mm) 500 ft (152 m) K6B86A

24 in (610 mm) 500 ft (152 m) K6B88A

30 in (762 mm) 500 ft (152 m) M2N05A

33.1 in (841 mm) 500 ft (152 m) K6B87A

36 in (914 mm) 500 ft (152 m) L4L08A

36 in (914 mm) 575 ft (175 m) M2N06A

HP Bright White Inkjet Paper, 3-in core 16.5 in (420 mm) 500 ft (152 m) L4Z41A

23.4 in (594 mm) 500 ft (152 m) L4Z42A

24 in (610 mm) 500 ft (152 m) L4Z44A

33.1 in (841 mm) 500 ft (152 m) L4Z43A

36 in (914 mm) 500 ft (152 m) L4Z45A

HP Premium Bond Paper, 3-in core 24 in (610 mm) 300 ft (91 m) L6B12A

33.1 in (841 mm) 300 ft (91 m) L6B11A

36 in (914 mm) 300 ft (91 m) L6B13A

40 in (1016 mm) 300 ft (91 m) L6B14A

Coated paper
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Name Width Length Product number

HP Universal Heavyweight Coated Paper, 3-in core 33.1 in (841 mm) 300 ft (91 m) L5C79A

36 in (914 mm) 300 ft (91 m) L5C80A

40 in (1016 mm) 300 ft (91 m) L5C81A

Poster paper

HP Production Matte Poster Paper, 3-in core 24 in (610 mm) 150 ft (46 m) N2V71A

24 in (610 mm) 300 ft (91 m) L5P96A

36 in (914 mm) 150 ft (46 m) N2V72A

36 in (914 mm) 300 ft (91 m) L5P97A

40 in (1016 mm) 150 ft (46 m) N2V73A

40 in (1016 mm) 300 ft (91 m) L5P98A

HP Production Satin Poster Paper, 3-in core 24 in (610 mm) 150 ft (46 m) N2V75A

24 in (610 mm) 300 ft (91 m) L5Q01A

36 in (914 mm) 150 ft (46 m) N2V76A

36 in (914 mm) 300 ft (91 m) L5Q02A

40 in (1016 mm) 150 ft (46 m) N2V77A

40 in (1016 mm) 300 ft (91 m) L5Q03A

HP Gloss Poster Paper, 3-in core 40 in (1016 mm) 200 ft (61 m) L5Q08A

Banner

HP Matte Polypropylene, 3-in core 40 in (1016 mm) 150 ft (46 m) L6B19A

Other supported paper types

Plain papers

● Plain paper < 90 g/m²

● Plain paper 90–110 g/m²

● Plain paper > 110 g/m²

● Recycled

● Colored paper

Technical papers

● Natural tracing paper (Asia-Pacific and Japan only)

● Vellum

● Translucent bond paper
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Coated papers

● Coated paper 90–100 g/m²

● Heavyweight coated paper

Poster papers

● Poster matte paper

● Poster satin paper

● Poster gloss paper

● Photo semi-gloss paper

● Blue-back paper

Banner and sign

● Polypropylene

● Tyvek 135 g/m²

Blueprint

● Blueprint

Paper status
The paper source displays the drawers in your printer, and one of the following status messages for each roll:

● Low on paper

● Out of paper

● Paper not loaded

● Calibration pending

● Check pending

● Unsuccessfully loaded

● Load malfunction

● Ready

● Error
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Load paper

1. Start the paper app to access the paper menu, then tap Load.

TIP: If the printer is not printing and the lock light on the drawer is off, you can skip this step.

2. Open the drawer.

WARNING! Do not stand on the drawer: the printer could fall over.

TIP: You can load more than one roll at the same time.

TIP: Load heavier rolls in upper drawers; they can weigh up to 18 kg (40 lb).

3. Open the locking levers on the left and right hubs.
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4. Move the hubs outwards (they are linked) to make room for the roll.

5. Place the roll into the drawer between the hubs, with the paper edge as shown.

Do not load the roll at an angle, like this:

6. Slide the hubs back towards the center so that they engage with the roll.
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7. Ensure that the hubs are fitted tightly to the roll on both sides.

8. Important: Close the locking levers on the left and right hubs.

9. Feed the paper into the appropriate slot: the front slot for the front roll, the rear slot for the rear roll.

TIP: The rear roll may need extra roll-ups to facilitate automatic feeding. Do not stop feeding until the 
paper is automatically advanced.

10. Continue feeding until you hear a beep.
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11. If the paper edge is not straight and clean, you can cut it off with the appropriate button (there is a button 
for each roll in the drawer).

When you press the button, the paper is advanced; when you release the button, the paper is cut.

Remember to remove the cut strip of paper.

12. Close the drawer when you have finished loading rolls into it.

13. Select the paper type on the front panel. The front panel remembers the last paper type loaded in this 
position, in case that helps.

14. When you are ready, tap Finish and check. The printer checks the position, width, and length of the loaded 
paper. The width and length are displayed on the main screen.

NOTE: If you do not select a paper type, the front panel waits a while and then executes Finish and check 
automatically.
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Unload paper
1. Ensure that the printer is not printing and that the lock light on the drawer is off.

2. Open the drawer.

WARNING! Do not stand on the drawer: the printer could fall over.

3. Remove the paper from the feeding slot.

4. Open the locking levers on the left and right hubs.

5. Slide the hubs to the side so that you can remove the roll.

6. Remove the roll (or the core, if only the core is left).

7. Close the locking levers on the left and right hubs.

8. Close the drawer.

Paper options
To see the paper options, tap  .

The following options are available:

● Edit type: You can modify the type of paper loaded.

● Protect paper types: You can protect selected paper types to avoid printing on them unintentionally.
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Store paper
To maintain paper quality, follow these recommendations:

● Store rolls in the original packaging within the temperature and humidity range specified on the paper 
label.

● When natural tracing paper is stored in a humid environment, its width when loaded can vary, and it may 
even jam in the printer. To avoid this, store this kind of paper in its packaging in humid conditions. Remove 
it from the printer in conditions of low temperature and high humidity (such as 15°C and 80% relative 
humidity). If you see that the paper has been affected by humidity, cut off the beginning of the roll: about 8 
m (26 ft).

● Store rolls covered by another piece of paper or cloth.

● Allow all papers to adapt to room conditions, out of the packaging, for 24 hours before using them for 
printing.

● The use of tape to stick the leading edge of the roll to the core is especially important for heavy papers, 
because the inherent stiffness of the paper can cause it to loosen and unwind from the core.

Cannot load paper
● Check that you have a roll in the selected drawer and slot.

● Check that the locking levers are closed on both hubs, and that the hubs are correctly positioned.

● Ensure that you locked the hubs before feeding paper into the printer.

● Check that the paper is correctly fed into the printer.

● Check that the paper is not crumpled or warped, and that the edges are straight.

● Check that the drawer is correctly closed.

● Check that the paper is wound tightly on the roll.

● Check that the paper is attached to the core.

● Check that you follow the paper specifications.

TIP: When loading rear rolls, you must feed more paper manually (about 40 cm, or 16 in) than with front rolls.
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Protect a paper type
You can protect selected paper types to avoid printing on them unintentionally. A protected paper type will be 
printed on only when the paper type is explicitly specified in the job.

To protect a paper type, go to the paper app, tap … for the paper type you want to protect, then Protect roll. 

Alternatively, you can tap  , then Job management > Automatic roll selection > Protected paper types.

When a paper type is protected, the  icon appears before the paper name.

To print on a protected roll, just select the paper type explicitly when submitting the job from a printer driver or 
other job submission software.

NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an out-of-
paper message will appear.

Paper jam

When the printer detects a jam, it tries to resolve the issue automatically. If it cannot, it stops, and you must fix 
the problem manually.

The front panel starts the paper jam wizard to display where the jam occurs and how to fix it.

Clear the paper jam as instructed on each screen of the wizard. When you have removed all the paper, tap Check 
now to check that the problem has been fixed successfully.
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Paper jam in a drawer

1. Open the drawer in which the paper jam has occurred.

2. Cut the paper if necessary.

3. Open the front cover of the drawer.

Areas where a jam may occur are identified with this label:
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4. Move the cutter to the right-hand side, unless it is there already.

CAUTION: Take care not to cut yourself when moving the cutter.

CAUTION: Do not dismantle the cutter assembly: refer it to qualified service personnel for servicing.

5. Remove the paper, cutting it manually if necessary.

6. Make sure there are no loose pieces of paper left in the drawer.

7. Close the front cover of the drawer.
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8. Rewind the paper.

9. Cut off the leading edge of the paper if it has been damaged.

10. Rewind again and feed the paper into the slot.

11. Use the paper-cut button to cut the leading edge again.

12. Close the drawer.

13. Wait until the printer is ready for paper.

14. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam in the paper access front cover

1. Open the front cover.
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2. Pull out the paper.

CAUTION: Be careful to pull out only the paper and not the struts of the printer.

3. Cut the paper if necessary.

IMPORTANT: Use scissors for this purpose, not a single blade.

4. Make sure there are no loose pieces of paper left.

5. Close the front cover.

6. Wait until the printer is ready for paper.

7. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.
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Paper jam in the paper output

1. Make sure that the jam is not in the accessory interface.

2. If you have a folder installed, raise the folder tray.

3. Push the button to raise the output module.

4. Pull out the paper.

CAUTION: Be careful not to touch the pinchwheels: they are sharp and can cut your fingers.
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5. Make sure there are no loose pieces of paper left.

6. Close the output module.

7. Wait until the printer is ready for paper.

8. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam in the top stacker
1. Open the rear cover.
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2. Pull out the paper.

3. Open the stacker.

4. Pull out the paper.

5. Close the rear cover.

ENWW Paper jam 47



6. Close the stacker.

7. Wait until the printer is ready for paper.

8. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam in the folder input (HP F60, HP F70, and HP PageWide XL folders)

1. Open the fan-fold cover to stop the folder motor and cut the power supply to it.

2. If necessary, cut the paper between the printer and the tray.

3. Remove the paper from the no-fold tray.

4. Unlatch and lift the folder input.

5. Pull out the paper from the tray.
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6. Push the button to raise the output module.

7. Pull out the paper.

CAUTION: Be careful not to touch the pinchwheels: they are sharp and can cut your fingers.

8. Make sure there are no loose pieces of paper left.

9. Close the output module.

10. Lower the tray.

11. Wait until the printer is ready for paper.

12. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam in the no-fold tray (HP F60, HP F70, and HP PageWide XL folders)

IMPORTANT: This operation must be performed by a service engineer or by someone else with appropriate 
training.

1. Open the top cover of the tray.
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2. Cut the paper between the printer and the folder, if necessary.

3. Remove the paper.

4. Close the cover.

CAUTION: Be careful where you place your hands.

5. Wait until the printer is ready for paper.

6. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam on the fan-folding path (HP F60, HP F70, and HP PageWide XL folders)

1. Try to remove the paper by pulling it from the no-fold tray. If you cannot remove all the paper this way, 
continue with the following steps.

2. Open the fan-folding cover.

3. Pull the paper out.

NOTE: You may see paper by the fan-fold tray or at the rear of the folder. Try to pull it out wherever you 
see it.
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4. Remove any remaining pieces of paper.

5. Ensure that the metal balls remain in place.

6. Close the cover.

7. Wait until the printer is ready for paper.

8. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam between the fan fold and cross-folding path
This should be easily visible from behind the folder. Open the fan-fold cover to stop the folder motor, and remove 
the paper.

Paper jam on the cross-folding path (HP F60, HP F70, and HP PageWide XL folders)

1. Open the cross-folding cover.
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2. Remove the paper.

CAUTION: Take care to avoid injury.

3. Close the cover.

4. Wait until the printer is ready for paper.

5. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.

Paper jam in the high-capacity stacker
1. Press the output button to raise the output module.

2. Remove the high-capacity stacker. You can pull the stacker by the beam at the rear of the tray.

3. Cut the paper between the printer and the high-capacity stacker, if necessary.
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4. Remove the paper from the high-capacity stacker.

5. Remove the paper from the printer.

6. Close the output module.

7. Reconnect the high-capacity stacker.
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8. Wait until the printer is ready for paper.

9. The printer resumes the job and automatically reprints any lost pages. However, you should check that all 
pages of the job have been printed.
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3 Ink system

● Ink cartridges 

● Print bar 

● Cleaning container 

● Maintenance cartridge 

● Safe mode 
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Ink cartridges 
The printer has two sets of ink cartridges in the order C1K1Y1M1 – C2K2Y2M2, with a capacity of 775 ml. One 
cartridge of each color is used at a time, the other is inactive until needed, and can be replaced while printing 
continues.

Below each ink cartridge, the printer has two LED indicators: a padlock and an inkdrop.

● The padlock LED is on when the cartridge is in use.

IMPORTANT: Do not try to remove a cartridge when the padlock LED is on.

● The inkdrop LED turns yellow when the cartridge is almost out of ink, and turns red when the cartridge is 
empty or faulty.

Ink cartridges require no maintenance or cleaning, but must be shaken before installation. High-quality printing is 
maintained even when the ink level is low.

CAUTION: Avoid touching pins, leads, and circuitry when handling ink cartridges, because these elements are 
sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See Glossary on page 144. 
Electrostatic discharges are one of the main hazards to electronics products. This type of damage can reduce the 
life expectancy of the device.

The status of each cartridge is reported in the front panel:

● OK: The cartridge is working normally.

● Reseat: The cartridge is not responding, but removing and reinserting it may solve the problem.

● Replace: The cartridge has been identified as faulty. It should be replaced by a functional cartridge.

● Low on ink: The cartridge is low on ink. It should be replaced soon.

● Very low on ink: The cartridge is very low on ink. It should be replaced very soon.

● Empty: The cartridge has no ink. It should be replaced.

● Missing: The cartridge is missing.

● Wrong/Incompatible/Incorrect: The cartridge type is not suitable for this printer.

● Expired: The cartridge has reached its expiration date.

● Altered: The cartridge has been identified as refilled or altered.
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Ink cartridge part numbers

PageWide Printer 775 ml C1Q45A HP 842A 775-ml Black Ink Cartridge

C1Q46A HP 842A 775-ml Cyan Ink Cartridge

C1Q47A HP 842A 775-ml Magenta Ink Cartridge

C1Q48A HP 842A 775-ml Yellow Ink Cartridge

C1Q49A HP 842B 775-ml Black Ink Cartridge

C1Q50A HP 842B 775-ml Cyan Ink Cartridge

C1Q51A HP 842B 775-ml Magenta Ink Cartridge

C1Q52A HP 842B 775-ml Yellow Ink Cartridge

C1Q53A HP 842C 775-ml Black Ink Cartridge

C1Q54A HP 842C 775-ml Cyan Ink Cartridge

C1Q55A HP 842C 775-ml Magenta Ink Cartridge

C1Q56A HP 842C 775-ml Yellow Ink Cartridge

Replace ink cartridges on the fly
You can replace a cartridge at any time when its padlock LED is off. If the padlock LED is on, you must pause the 
job queue and wait until the LED turns off.

Replace ink cartridges from the front panel

1. Go to the front panel and tap  , then the Ink cartridges tab, then Replace.

If a cartridge runs out of ink, the printer will automatically try to switch to the other cartridge of the same 
color, after which you can replace the empty cartridge without any interruption to printing. If the ink 
cartridge you want to replace is locked, you will need to pause the job queue to continue.

2. When prompted, press the old cartridge and slide it up to release it.
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3. Shake the new cartridge six times.

4. Insert the new cartridge and push it in as far as it will go.

5. Follow the instructions in the front panel.

6. When you have replaced all cartridges that you want to replace, tap Finish and check.

7. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink 
system consumables.

If a cartridge runs out of ink, the printer will automatically try to switch to the other cartridge of the same color, 
after which you can replace the empty cartridge without any interruption to printing.

If the available ink is exhausted while printing a page, printing stops and the page is ejected. When a new 
cartridge is inserted, printing can resume, and the interrupted page is reprinted in full.

HP recommends that you replace an empty cartridge with a new HP cartridge. See Ink cartridge part numbers 
on page 57.
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The use of refilled or altered ink cartridges has several serious disadvantages:

● There is some risk of damaging the printer. In this case the printer warranty will not be valid for any printer 
repairs that are related to the cartridge, nor for any problems due to ink contamination.

● You will invalidate the warranty of all printheads of the same color used in the printer subsequently.

● Print quality may be impaired.

● The printer will be unable to estimate the ink level in the cartridge, and will not report it.

If you want to force the printer to accept what it sees as an empty cartridge, proceed as follows:

1. Tap  on the front panel, then  ,  ,  ,  .

2. The front panel notifies you that the cartridge is altered, and the cartridge acceptance process starts. 
Follow the instructions displayed on the front panel. If your cartridge is not an Original HP cartridge, HP 
recommends that you stop the process. To check the authenticity of your cartridges, go to 
http://www.hp.com/go/anticounterfeit.

3. If you proceed, the front panel displays a series of warning messages.

When the process is finished, the front panel gives the usual ink cartridge display, but the cartridge does not 
report its ink level.

NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip. 
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at: 
http://www.hp.com/go/learnaboutsupplies.

Ink cartridge maintenance
During the normal lifetime of a cartridge, no specific maintenance is required. You should replace a cartridge 
when it has reached its expiry date. You can find the expiry date in the the ink cartridge information on the front 
panel.

Ink cartridge troubleshooting
1. Check that you have the correct type of cartridge (model number).

2. Check that the cartridge label is the same color as the slot label.

3. Check that the cartridge is correctly oriented: the arrow on the front of the cartridge should face upwards.

CAUTION: Never clean inside the ink cartridge slots.

Print bar 
The key printing element is a fixed 40 inch (1016 mm) print bar, composed of 8 printheads, numbered 1 to 8 
from left to right, looking at the printer from the front. The paper advances at high speed underneath the print 
bar, which ejects pigmented inks in four colors.
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The printheads are extremely durable and do not need to be replaced every time an ink cartridge is replaced. 
They provide excellent results even when the ink cartridges contain a low level of ink.

To maintain optimum print quality, the printheads are automatically tested at regular intervals, and automatically 
serviced when necessary. This takes a little time and can occasionally delay printing. When a printhead 
eventually needs to be replaced, the front panel will display a message.

The printer’s paper-loading system includes an auto-indexing facility: whenever paper is loaded, the printer 
moves the position of the roll to compensate for printhead nozzle usage and extend the lifetime of each 
printhead. This is an automatic behavior, but you may notice that the front and rear rolls change position slightly 
between rolls.

CAUTION: Do not touch the printhead nozzles.

CAUTION: Do not put the printhead down on any surface for any reason.

TIP: Printheads are best preserved inside the printer. Moreover, if you remove the printheads, the printer will 
need to be recalibrated whenever you put them back. Therefore you are recommended not to remove them 
unnecessarily.

Printhead status

● OK: The printhead is working normally.

● Missing: No printhead is detected in the slot.

● Replace: The printhead has been identified as faulty. It should be replaced by a new or working printhead.

● Reseat: The printhead has been identified as faulty, but removing and reinserting it may perhaps solve the 
problem.
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● Remove: The printhead needs to be removed.

● Printhead replacement incomplete. Restart it.

The printhead did not complete the replacement procedure. You must restart the replacement and fully 
complete it.

● If the warranty status is Out of warranty, this indicates that the warranty conditions have expired (for 
example, ink consumption exceeds the warranteed limit).

NOTE: If a printhead is out of warranty, one of three possible status values may be seen in its health 
gauge:

– OK: The printhead can print normally.

– Monitor IQ: Print quality may not be maintained in all prints.

– Recover: You are recommended to use enhanced printhead recovery on that printhead (see Enhanced 
printhead recovery on page 118).

If the warranty status is See warranty note, this indicates that the warranty conditions have been breached 
(for example, expired or non-HP ink has been used).

You can check the warranty status in the printer information app.

See the limited warranty document provided with your printer for details of the warranty implications.

Printhead part number
The HP 841 printhead has the part number C1Q19A.

Replace printheads
Printheads rarely need to be replaced, but the front panel will tell you when a printhead is failing or has reached 
the end of its life.

Alternatively, a test print may indicate a printhead problem before the printer detects it.

CAUTION: Avoid touching pins, leads, and circuitry when handling printheads, because these elements are 
sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See Glossary on page 144. 
Electrostatic discharges are one of the main hazards to electronics products. This type of damage can reduce the 
life expectancy of the device.

IMPORTANT: Recalibrate the printer after any printhead replacement (see Calibrate print bar on page 116). 
Make sure you have the right paper for the calibration loaded before replacing the printhead. Use gloves when 
handling any component of the ink system.
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1. Ensure that all ink cartridges are at least 25% full.

2. Start the printhead replacement from the front panel: tap  , then the Printhead tab, then Replace.

3. If you have a top stacker, open it.

4. Wait for the print bar to reach the replacement position.

5. Open the top cover with both hands by pressing the side buttons.

6. Open the print-bar cover.

7. Identify the printhead(s) that you want to replace.

NOTE: You can replace more than one printhead at a time.

8. Pull up the printhead handle.
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9. Lift the latch.
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10. Extract the printhead carefully.

IMPORTANT: Printheads are fragile. Leave the printhead oriented as shown below, if you intend to use it 
again later. Never touch the nozzles, which could damage them. If you remove multiple printheads and 
intend to use them later, make sure to keep them in the right order.

11. Slowly remove the protective caps from the new printhead in the order shown below.
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12. Insert the new printhead as shown below.

13. Press it in firmly until you feel resistance.

14. Close the latch.

15. Close the handle.

16. Close the top cover.

17. If you have a top stacker, close it.

18. Tap Continue and wait about 24 minutes while the printer performs automatic calibrations and checks.

19. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink 
system consumables.

Printhead maintenance
The printer and the maintenance cartridge clean the printheads automatically.

Avoid removing printheads unnecessarily.

Printhead troubleshooting
1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the orange protective caps from the printhead.

3. Check that the printhead is correctly oriented: compare it with the others.
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4. Check that you have closed and latched the printhead cover.

5. If you still have problems when printing, see Print quality on page 113.

Cleaning container
The cleaning container is a replaceable part that collects waste ink in liquid form, with a capacity of about 2 liters.

The cleaning container is designed to keep the printer’s waste ink from damaging the printer and dirtying its 
surroundings.

In order to achieve these objectives, you must ensure that it is correctly installed and maintained, changing it 
when prompted by the front panel.

TIP: You are recommended to wear gloves when replacing the cleaning container.

Always replace the cleaning container with the printer switched on, otherwise the counters may not work 
properly.

If the printer continues operating while the container is incorrectly installed or connected, HP will not be 
responsible for any resulting damage or cleaning expenses.

You can check the cleaning container status in the front panel.

Cleaning container status

● Ready

● Missing: The cleaning container is not detected.

● Almost full: This is estimated by the printer.

● Full: The printer has stopped printing. It will continue after the cleaning container has been replaced.

Cleaning container part number
The HP 841 cleaning container has the part number F9J47A.
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Replace the cleaning container

1. At the front panel, tap  , then  , then Cleaning container > Replace.

2. Locate the cleaning container.

3. Extract the cleaning container: lift it a little, then pull it out.

TIP: If you leave the printer without a cleaning container for long, some drops of liquid may escape and 
stain the floor. Try to replace it rapidly.

4. Remove the packaging from the new cleaning container.

5. Insert the new cleaning container in place of the old one.

NOTE: If you insert a cleaning container that has been used in another printer, the Almost full warning will 
be unreliable.

6. The printer checks the installation.

7. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink 
system consumables.
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Cleaning container troubleshooting
If the cleaning container is correctly installed but the printer does not detect it, first try taking it out and putting it 
back again. If that fails, call your support representative.

Maintenance cartridge
The maintenance cartridge cleans and maintains the printheads, and stores waste ink.

The maintenance cartridge contains a roll of cloth, which is used to clean the printheads. It has a total capacity of 
500 wipes (cleaning operations). A heavy user will need to replace it about every 2 months.

The printer will refuse to start a print job if it detects the end of the cleaning roll. You should then replace the 
maintenance cartridge with a new one.

TIP: You are recommended to wear gloves when replacing the maintenance cartridge.

Maintenance cartridge status

● Ready

● Missing

● Almost finished

● Finished

Maintenance cartridge part number
The HP 841 maintenance cartridge has the part number F9J48A.

Replace the maintenance cartridge

IMPORTANT: Be ready with the new maintenance cartridge before starting the replacement. Once the cartridge 
is moved to the replacement position, you have 40 seconds to change it. If you exceed that limit, the 
maintenance cartridge is automatically moved back so that the printheads do not become dry. If the front panel 
shows an error, close the service door.

1. Remove the packaging from the new maintenance cartridge.

2. Start the replacement from the front panel.
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3. When prompted by the front panel, open the maintenance cartridge door.

IMPORTANT: When removing a maintenance cartridge, remember that it contains ink. Therefore, wear 
gloves and hold the cartridge by the handle.

4. To remove the maintenance cartridge, grip the handle and slide it out.

5. If you intend to insert a partially used replacement cartridge, make a note of the percentage of cloth 
remaining, which is shown approximately on the side of the cartridge. You will be asked for this figure later.
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6. Insert the new maintenance cartridge into the slot.

IMPORTANT: Be careful to insert the maintenance cartridge correctly.

7. Push in the maintenance cartridge into place; do not use excessive force.

NOTE: The front panel will not show the new maintenance cartridge until the door is closed.

8. Close the door.

9. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink 
system consumables.

NOTE: In order to start printing, the printer needs all the ink cartridges, printheads, and maintenance cartridge 
to be installed, and the printer window and maintenance cartridge door to be closed.

The front panel asks whether the cartridge is new or used. If used, you are asked to enter the percentage of cloth 
remaining. This information is used by the printer to estimate when the cartridge will need replacing.

Maintenance cartridge troubleshooting
If the printer does not detect the maintenance cartridge that you have inserted, open the door and make sure the 
maintenance cartridge is correctly inserted. If this does not solve the problem, contact your support 
representative.
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Safe mode
Under certain conditions, including printer operation outside of environmental specifications, and when a used, 
refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode. HP is unable to 
warrant the performance of the printing system when operated outside of environmental specifications or when 
a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the 
printheads from damage due to unexpected conditions, and is in operation when the icon is displayed on the 
printer’s front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including original HP inks 
and printheads, are designed and engineered together to provide uncompromising print quality, consistency, 
performance, durability, and value—with every print.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous 
ink system and install genuine HP (or compatible) cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to 
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or 
compatible) to continue printing.

NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip. 
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at: 
http://www.hp.com/go/learnaboutsupplies.
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4 Networking

● Introduction

● Control network protocols

● Front-panel menu items

● Link configuration methods

● Troubleshooting 
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Introduction
The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B limits, the 
use of shielded I/O cables is required.

The embedded Jetdirect print server supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 802.3u 
100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected and 
powered on, the printer auto-negotiates with your network to operate with a link speed of 10, 100, or 1000 
Mbps, and to communicate using full- or half-duplex mode. However, you can manually configure the link using 
the printer's front panel, or through other configuration tools once network communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For 
security, it includes features to control IP traffic to and from the printer and supports configuration of IP Security 
(IPsec) protocols.

Control network protocols
The printer can simultaneously support multiple network communication protocols. This allows network 
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. For some 
protocols, required parameters are automatically sensed and user-specified settings are not needed. However, 
for other protocols, there may be many parameters to configure.

Enable or disable network protocols
If a network protocol is enabled, the printer may actively transmit on the network even when there are no 
computers on the network that use the protocol. This may increase network traffic. To eliminate unnecessary 
traffic, you can disable unused protocols. Disabling unused protocols lets you:

● Reduce network traffic by eliminating broadcast messages from unused protocols

● Provide better control over who prints to the printer by eliminating users from other networks who might 
route print jobs to this printer

● Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front-panel menu items on page 73. 
For other tools, such as system command access to the embedded Telnet server, see the HP Jetdirect Print Server 
Administrator’s Guide for your print server model.
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Front-panel menu items

To access the printer network configuration settings, go to the front panel and tap  , then  , then 

Gigabit Ethernet.

Menu item Sub-menu item Sub-menu item Values and Description

Information Print Sec Report  Yes : Prints a report.

No (default): Does not print a report.

TCP/IP   Host Name  An alphanumeric string, up to 32 characters, used to 
identify the device. This name is listed on the HP Jetdirect 
configuration page. The default host name is NPIxxxxxx, 
where xxxxxx is the last six digits of the LAN hardware 
(MAC) address.

 IPV4 Settings Config Method Specifies the method that TCP/IPv4 parameters will be 
configured on the HP Jetdirect print server.

Bootp : Use BootP (Bootstrap Protocol) for automatic 
configuration from a BootP server.

DHCP (default): Use DHCP (Dynamic Host Configuration 
Protocol) for automatic configuration from a DHCPv4 
server. If selected and a DHCP lease exists, DHCP Release 
and DHCP Renew menus are available to set DHCP lease 
options.

Auto IP : Use automatic link-local IPv4 addressing. An 
address in the form 169.254.x.x is assigned automatically.

Manual : Use the Manual Settings menu to configure TCP/
IPv4 parameters.

  DHCP Release This menu appears if Config Method was set to DHCP and a 
DHCP lease for the print server exists.

No (default): The current DHCP lease is saved.

Yes : The current DHCP lease and the leased IP address are 
released.

  DHCP Renew This menu appears if Config Method was set to DHCP and a 
DHCP lease for the print server exists.

No (default): The print server does not request to renew the 
DHCP lease.

Yes : The print server requests to renew the current DHCP 
lease.

  Manual Settings (Available only if Config Method is set to Manual ) Configure 
parameters directly from the printer control panel:

IP Address : The unique IP address of the printer (n.n.n.n).

Subnet Mask : The subnet mask for the printer (n.n.n.n).

Syslog Server : The IP address of the syslog server (n.n.n.n) 
used to receive and log syslog messages.

Default Gateway : The IP address (n.n.n.n) of the gateway or 
router used for communications with other networks.

Idle Timeout : The time period, in seconds, after which an 
idle TCP print data connection is closed (default is 270 
seconds, 0 disables the timeout).
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Menu item Sub-menu item Sub-menu item Values and Description

  Default IP Specify the IP address to default to when the print server is 
unable to obtain an IP address from the network during a 
forced TCP/IP reconfiguration (for example, when manually 
configured to use BootP or DHCP).

Auto IP : A link-local IP address 169.254.x.x is set.

Legacy : The address 192.0.0.192 is set, consistent with 
older HP Jetdirect devices.

  Primary DNS Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configuration is a 
higher priority than DHCP in the Config. Precedence table, 
configured through the embedded Web server.

  Secondary DNS Specify the IP address (n.n.n.n) of a Secondary Domain 
Name System (DNS) Server.

NOTE: This item will appear only if Manual configuration is 
a higher priority than DHCP in the Config. Precedence table, 
configured through the embedded Web server.

 IPV6 Settings Enable Use this item to enable or disable IPv6 operation on the 
print server.

Off : IPv6 is disabled.

On (default): IPv6 is enabled.

  Address Use this item to manually configure an IPv6 address.

Manual Settings : Use the Manual Settings menu to enable 
and manually configure a TCP/ IPv6 address.

Enable : Select this item and choose On to enable manual 
configuration, or Off to disable manual configuration.

Address : Use this item to type a 32 hexadecimal digit IPv6 
node address that uses the colon hexadecimal syntax.

  DHCPV6 Policy Router Specified : The stateful auto-configuration method 
to be used by the print server is determined by a router. 
The router specifies whether the print server obtains its 
address, its configuration information, or both from a 
DHCPv6 server.

Router Unavailable : If a router is not available, the print 
server should attempt to obtain its stateful configuration 
from a DHCPv6 server.

Always : Whether or not a router is available, the print 
server always attempts to obtain its stateful configuration 
from a DHCPv6 server.

  Primary DNS Use this item to specify an IPv6 address for a primary DNS 
server that the print server should use.

NOTE: This item will appear only if Manual configuration is 
a higher priority than DHCP in the Config Precedence table, 
configured through the embedded Web server.

  Secondary DNS Use this item to specify an IPv6 address for a secondary 
DNS server that the print server should use.

NOTE: This item will appear only if Manual configuration is 
a higher priority than DHCP in the Config Precedence table, 
configured through the embedded Web server.
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Menu item Sub-menu item Sub-menu item Values and Description

 Proxy Server  Specifies the proxy server to be used by embedded 
applications in the device. A proxy server is typically used 
by network clients for Internet access. It caches Web pages, 
and provides a degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-
qualified domain name. The name can be up to 255 octets.

For some networks, you may need to contact your 
Independent Service Provider (ISP) for the proxy server 
address.

Proxy Port  Type the port number used by the proxy server for client 
support. The port number identifies the port reserved for 
proxy activity on your network, and can be a value from 0 
to 65535.

Security  Print Sec Page  Yes : Prints a page that contains the current IPsec security 
settings on the HP Jetdirect print server.

No (default): A security settings page is not printed.

Secure Web  For configuration management, specify whether the 
embedded Web server will accept communications using 
HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS Required: For secure, encrypted communications, 
only HTTPS access is accepted. The print server will appear 
as a secure site.

HTTP/HTTPS optional: Access using either HTTP or HTTPS 
is permitted.

NOTE: The factory default setting depends on the print 
server model.

IPSEC   Specify the IPsec or Firewall status on the print server.

Keep : IPsec/Firewall status remains the same as currently 
configured.

Disable : IPsec/Firewall operation on the print server is 
disabled.

802.1x   

Enable Wipe   
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Menu item Sub-menu item Sub-menu item Values and Description

Reset Security   Specify whether the current security settings on the print 
server will be saved or reset to factory defaults.

No (default): The current security settings are maintained.

Yes : Security settings are reset to factory defaults.

Link Speed    The link speed and communication mode of the print 
server must match the network. The available settings 
depend on the device and installed print server. Select one 
of the following link configuration settings:

CAUTION: If you change the link setting, network 
communications with the print server and network device 
might be lost.

Auto (default): The print server uses auto-negotiation to 
configure itself with the highest link speed and 
communication mode allowed. If auto-negotiation fails, 
either 100TX HALF or 10TX HALF is set depending on the 
detected link speed of the hub/switch port. (A 1000T half-
duplex selection is not supported.)

10T Half : 10 Mbps, half-duplex operation.

10T Full : 10 Mbps, Full-duplex operation.

100TX Half : 100 Mbps, half-duplex operation.

100TX Full : 100 Mbps, full-duplex operation.

100TX Auto : Limits auto-negotiation to a maximum link 
speed of 100 Mbps.

1000TX Full : 1000 Mbps, full-duplex operation.

Link configuration methods
The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex communication 
modes (a 1000T half-duplex selection is not supported). By default, it will attempt to auto-negotiate its link 
operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will configure 
itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-negotiating 10 
Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.

If the printer is not able to connect to the network through auto-negotiation, you can set the link setting by one 
of the following methods:

● The front panel

● The Embedded Web Server

● The Telnet interface, through a system command prompt

● A TFTP (Trivial File Transfer Protocol) configuration file that is downloaded, for example, from a BootP or 
DHCP server

● Network management tools such as HP Web Jetadmin
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Troubleshooting

IO Configuration page
The IO Configuration page provides comprehensive print server status. It is an important diagnostic tool, 
especially if network communications are not available. For a description of messages that may appear on the IO 
Configuration page, see the HP Jetdirect Print Servers Administrator’s Guide for your print server model.

To print the IO Configuration page, go to the front panel and tap  , then Connectivity > Print Connectivity 

Configuration.

To verify correct operation:

1. Print an IO Configuration page to check for status messages.

2. In the upper section of the IO Configuration page, look for the status message I/O Card Ready.

3. If I/O Card Ready appears, the print server is operating properly. Proceed to the next section.

If a message other than I/O Card Ready appears, try the following:

a. Turn the printer off and then on again to re-initialize the print server.

b. Check that the status indicator lights (LEDs) are providing proper status.

See the HP Jetdirect Print Servers Administrator’s Guide for your print server model to interpret and troubleshoot 
other messages.

Reset network parameters
If you accidentally misconfigured the printer’s network settings, they can be reset to factory default values by 

tapping  , then  , then  , then Restore factory settings.

CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved during reset to factory default values. 
However, a Certificate Authority (CA) certificate that has been installed by the user to validate a network 
authentication server will not be saved.

Link troubleshooting
The printer has status lights (LEDs) beside the network connector that indicate the link status and network 
activity.

● When the green light is on, the printer has successfully linked to the network.

● When the yellow light is blinking, there is network transmission activity.

If the printer does not successfully connect to the network:

● Both LEDs will be off.

● LAN Error – Loss of Carrier will be indicated on the IO Configuration page.
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In this situation, try the following:

1. Check the cable connections at both ends.

2. Consider replacing the cables by known good ones.

3. Consider switching to another network connector in the network switch, hub, or device to which the printer 
is connected.

4. Manually configure the link setting to match the port configuration of the network hub or switch. For 
manual configuration methods, see Link configuration methods on page 77. Turn the printer off, then on 
again, to re-initialize the setting.

5. Print an IO Configuration page and check link settings.

Item Description

Port Config If the printer is properly linked, this item has one of the following values:

● 10BASE-T HALF: 10 Mbps, half-duplex

● 10BASE-T FULL: 10 Mbps, full-duplex

● 100TX-HALF: 100 Mbps, half-duplex

● 100TX-FULL: 100 Mbps, full-duplex

● 1000TX FULL

If the printer is not properly linked, one of the following messages will appear:

● UNKNOWN: The printer is in an initialization state.

● DISCONNECTED: A network connection has not been detected. Check network cables. Reconfigure the 
link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

● ON (default): The printer will attempt to automatically configure itself onto the network at the proper 
speed and communication mode.

● OFF: You must manually configure the link speed and communication mode using the front panel. Your 
settings must match those of the network for proper operation.

6. In case of doubt or misconfiguration of link settings, reset the network parameters to their factory settings. 
See Reset network parameters on page 78.

Communication failures between computer and printer
Some symptoms are:

● The front-panel display does not show the Received jobs message when you have sent jobs to the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Print jobs get stuck in your computer’s print spooler.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so on).

ENWW Troubleshooting 79



To solve a communication problem:

● Ensure that you have selected the correct printer when sending your job.

● Ensure that the printer works correctly when printing from other applications.

● If your printer is connected to your computer through any other intermediate devices, such as switch boxes, 
buffer boxes, cable adapters, or cable converters, try using it when connected directly to your computer.

● Try another network cable.

● Remember that very large prints may take some time to receive, process, and print.

● If your printer displays warning or error messages that require action, take the required action before trying 
to print.

Cannot access the Embedded Web Server
1. If you have not done so already, read Embedded Web Server on page 13.

2. Make sure that Embedded Web Server functionality is enabled in the printer: from the front panel, tap 

 , then Security > Connectivity > Embedded Web Server (EWS) > On .

3. Check the proxy configuration in your Web browser in case it is preventing communication with the printer.

4. Ensure that the printer works correctly when printing or accessed from other applications.

5. If the printer displays warning or error messages that require further action, take the action to resolve the 
problems.

6. If all else fails, turn the printer off and on again with the power key on the front panel.

Cannot access the printer from the HP Utility
1. If you have not done so already, read HP Utility on page 12.

2. Make sure your printer driver is available and working correctly for the HP DesignJet Utility in Windows.

3. From the front panel, tap  , then Security > Web services > Printing & management, and make sure 

that it is enabled. If it is disabled, some parts of the HP Utility may not work properly.

Print jobs take too much time to be received by the printer
Very large prints may take some time to receive, process, and print. However, if there is an unusually long delay 
after sending print jobs to the printer until they appear in the front panel’s job queue, there are various things 
you could check:

● Make sure the network cable connected to the printer is rated at least Cat5e.

● Make sure that gigabit-speed networking equipment and cabling interconnects your computer client to the 
printer.

● Make sure that there are no network link issues. See Link troubleshooting on page 78.
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● Take into account that, in network deployments with IPSec security protocols enabled and configured in the 
printer, network performance may be reduced due to the use of cryptographic algorithms to protect 
network communications.

● If you experience low-performance network issues when using tools such as HP SmartStream or third-
party RIPs, check that the RIP printing service and high-speed printing ports 9101 and 9102 are enabled in 
Embedded Web Server > Networking > Other settings > High-speed RIP mode > Enable high-speed mode.

● Try resetting the network configuration to its factory settings in order to get default settings that are 
suitable for most standard network environments. See Reset network parameters on page 78.

● You may also find it helpful to test connecting the computer to the printer directly, using a normal Ethernet 
(Cat5e or Cat6) cable point-to-point, without passing through an Ethernet switch or router. In this 
configuration, the printer and the computer should both automatically change their IPv4 addresses to the 
form 169.254.x.x . In this point-to-point configuration you can discard any issues caused by other network 
equipment.
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5 Sending a job to print

There are various different ways in which you can choose to print, depending on your circumstances and 
preferences:

● From HP SmartStream: See the HP SmartStream documentation at http://www.hp.com/go/
smartstreampagewidexl/manuals/.

● From a printer driver: Print any kind of file from a computer connected to the printer by network, using a 
software application that can open the file, and a printer driver supplied with your printer. See Print from 
the driver on page 83.

● From a USB flash drive: Print a file directly from a USB flash drive. See Print from a USB flash drive 
on page 86.

● From a RIP: You can use a Raster Image Processor (RIP) program, run on a separate computer, to send jobs 
to the printer. RIP software is available from various different companies. See your RIP vendor’s 
documentation.

● Print a file that is already in the job queue. See Queue management on page 90.
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Print from the driver
This is the traditional way of printing from a computer. The correct printer driver must be installed on the 
computer, and the computer must be connected to the printer by network.

When the printer driver has been installed and the computer is connected to the printer, you can print from a 
software application by using the application's own Print command and selecting the correct printer.

NOTE: When first printing, Windows automatically searches for the printer driver on the Internet (if the 
computer is connected to the Internet). This means that you do not need to search for the driver yourself. 
However, this process will install the driver without the rest of the software. Therefore, we recommend 
installation using the install package that you can download from HP's website http://www.hp.com/go/
pagewidexlseries/support/drivers, so that all of the printer software is installed.

Check and change main driver settings
There are a relatively large number of print settings that you can use when printing with a printer driver, to try to 
satisfy all requirements. When printing from an application, you can see the driver settings by clicking File > Print 
and then Print options or Properties (depending on the application).
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TIP: In general you are recommended to use the default settings unless you know that they do not meet your 
requirements. The printer will apply its own policies regarding roll and paper to choose the most suitable for your 
job.

TIP: Windows only: If you intend to reuse a particular group of settings repeatedly, you can save those settings 
under a name of your own choice and recall them later. A saved group of settings is known as a quickset.
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The printer drivers support any accessories such as a stacker or folder connected to your printer. The printer’s 
default output is also the driver’s default output. However, from the driver you can change the output destination 
and other options such as the folding style, collation, and first or last page on top.

Job storage and PIN printing
Job storage allows jobs to be stored and then printed when required, it also provides features for setting print 
jobs as private, with a personal identification number (PIN). To access job storage features, open the printer 
properties, and then click Printing Preferences. Click the Job Storage tab, where the following job storage 
features are available:

● Print and store: After a job has printed, it is stored in the printer; more copies can then be printed from the 
front panel.

● Print and delete: Once printed, the job is automatically removed from the printer.
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● Retrieve from front panel (personal job): Use the personal job printing feature to specify that a job cannot 
be printed until you release it from the printer's front panel.

To preview it in the Embedded Web Server, you will need to enter the PIN.

● Retrieve from front panel (private job): Use the private printing feature to specify that a job cannot be 
printed until you release it with a PIN. First, click Retrieve from front panel (private job), after which the PIN 
to Print checkbox will be available. If checked, a 4-digit personal identification number must be set. The PIN 
is sent to the printer as part of the print job. After sending the print job, use the PIN to print the job. Once 
printed, it is automatically removed from the printer.

To preview it in the Embedded Web Server or in the front panel, you will need to enter the PIN.

TIP: Define a user name and a job name in the job storage tab for easy identification in the job queue.

Print from a USB flash drive
1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript files into the 

printer's USB port.

NOTE: To print PDF or PostScript file, you must have a PostScript printer.

NOTE: The use of USB flash drives with your printer may be disabled by the administrator.

2. At the front panel, go to the home screen and tap  .

You can tap folders to browse their contents. Files are shown as document thumbnails, and you can 
preview a file by tapping the preview icon. When the preview is displayed, you can zoom in and out. Files 

that cannot be printed are indicated with  .

3. Select a file to be printed. Multipage documents are supported only in PDF files; in this case, you can also 
select a page to print.

4. The list of print-from-USB quicksets is displayed. You can choose and/or edit one of the quicksets for the 
selected job.

The following settings are available:

● Quickset name allows you to name the quickset you are working with.

● Output scale allows you to resize the print in two different ways: to a percentage of its original size, or 
to fit a particular paper size. The default is 100% (its original size).

● Print quality allows you to set the print quality to Lines/Fast, Uniform areas, or High detail.
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● Color options allows you to choose color or grayscale.

● Paper source allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which 
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

NOTE: The printer setting Roll width selection has two values: Print on same width only and Print on 
same width or wider. When Print on same width only is selected, each page is printed only on a roll 
with the same width as the page.

● Output destination allows you to direct output to the stacker (the default) or the basket.

● Page order allows you to choose first page on top, or last page on top.

● Collate allows you to turn collation on or off.

● Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which 
rotates the print automatically if that will save paper.

● Printer margins allows you to change the default printer margins.

● Storage mode offers two options, print and delete (the job is not retained in the job queue) and print 
and store (the job is retained in the job queue).

● Folding style allows you to select the folding style when the folder is installed. To use the folder, you 
must select Folder in the Output destination setting.

● Cutter allows you to disable cutting between copies or at the end of the job. You can change the 

default behavior by tapping  , then Job management > Cutter off.

● Alignment allows you to decide the position of the image on the roll.

NOTE: If you edit a quickset after selecting a job, the changed settings are applied only to the current job 
and are not saved permanently. You can change any of your own quicksets permanently by tapping  on 

the quicksets screen, or by tapping  , then Print, Scan & Copy quicksets > Print from USB quicksets.

NOTE: The factory quicksets cannot be modified.

5. When you are satisfied with the quickset settings, tap OK to continue.

6. A screen with the following settings appears: Copies, Page order, and Collate. You can check and change 
them in this step, regardless of the settings in the quickset. Tap Print to continue.

7. After printing, you can choose to print another file or go to the job queue. If you print another file 
immediately without returning to the home screen, the temporary settings used for the previous file are 
used again.

Print by email (HP ePrint)  

This option is disabled by default, but can be enabled from the front panel by tapping  , then Connectivity 

> HP Connected > HP ePrint connectivity. You can also configure HP ePrint from the front panel’s HP Connected 
screen.

When enabled, the HP ePrint icon is added to the front panel as shown below:
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You can find your printer’s email address by tapping the new icon. If you want to change the address or restrict its 
use, you can do so from http://www.hpconnected.com.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver. There 
are a few limitations that you should bear in mind:

● The attached files to be printed must be in PDF, JPEG, or TIFF formats.

● The maximum file size is 10 MB, but your email server may have a lower limit.

● Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in 
portrait orientation (some printers may offer autorotation).

Select print quality
The printer has three print-quality modes which have been designed, as their names indicate, to match the 
specific needs of different kinds of images.

Although all print-quality modes are for 1-pass printing (in contrast to HP DesignJet printers), several 
parameters such as print speed, color strategy, and image processing have been optimized for each case.

Refer to the print-mode table and diagram below for guidance on selecting the most appropriate print mode for 
your purposes.

 If the image content is…
Recommended print 
mode You will obtain…

A
Monochrome or color lines and text

Any content if maximum productivity is needed
Lines/Fast HIgh-quality lines with maximum productivity

B Large areas of uniform colors Uniform areas More uniform and saturated colors for long-
distance viewing

C
Text or lines on top of color backgrounds

Highly complex drawings with plenty of detail
High detail Smooth background with fine detail in lines and 

text

NOTE: The intention of the Lines/Fast mode is twofold: it can be used for images with only lines and text, or for 
any kind of image when you need maximum productivity.
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6 Queue management 

● Job queue introduction

● Job queue actions 

● Job queue options 

● When to start printing 

● Default printing preferences 

● Job deletion 

● Job queue in the Embedded Web Server
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Job queue introduction

Tap  on the home screen to view the job queue on the front panel. You can also view the job queue in the 

Embedded Web Server: see Job queue in the Embedded Web Server on page 96.

The print queue includes jobs that are being received, parsed, rendered, printed, already printed, and so on.

Tap  to show the toolbar. You can see all the job details by selecting the job, including information about 
status, pages, copies, total, and preview.

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below and jobs 
to be printed above. You can scroll up and down. Once scrolled, the queue remains static and does not move 
automatically.

Jobs in the left pane are divided into four categories (Up next, Now printing, On hold, and History) in chronological 
order starting from the top. On hold is shown only when there are one or more jobs on hold. Below the job name, 
you can see its status:

Up next

● Waiting to process: The job has been received by the printer and is waiting to be rendered.

● Processing: The printer is parsing and rendering the job.

● Waiting to print or Paused: The job is processed and waiting for the print engine to be ready to proceed with 
printing.

Now printing

The job is being printed.

● Paused: The job is paused.

NOTE: Sometimes, while printing, you may see a Self-servicing status, which means that the printer is 
performing some task such as paper type change or print mode change between pages of the same job.

On hold

The job will not be printed until you take some action. You should respond in one of the following ways:

● On hold: Private job: Enter the PIN required to print the job. The job will be deleted from the queue after 
printing.

● Oh hold: Personal job: The job is not automatically printed: you must select it from the queue. No details 
can be seen.
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● On hold to preview: The job is not automatically printed: you must select it from the queue.

● On hold for paper mismatch: Load the paper required by the job.

● On hold for output mismatch: Enable or change the output required by the job.

● On hold for accounting: Enter an account ID to be used for the job.

● On hold: Recovered job: After a printer recovery, some jobs that were not printed are kept on hold.

● On hold for supplies: The printer needs paper, ink cartridge, printhead, cleaning container, or maintenance 
cartridge to be replaced.

History

● Printed: In chronological order, divided into today, yesterday, last week, and so on.

● Canceled: Canceled by the user.

● Failed: The job has failed for one or more reasons.

Job queue actions
Some of the actions in the job queue are determined by the settings selected. Some default settings may be 

worth changing, depending on your environment. To do so, tap  in the home screen, then Job 

management. Alternatively, in the job queue app, tap the … button on the top right, then Settings.

Pause the job queue

You can pause the job queue by tapping  and resume by tapping  . The pause takes effect at the end 

of the page that is currently printing.

Reprint
In the History section, select the job you want to reprint and tap Reprint. In the next screen you can select the 
number of copies, collated or not, page order, source, and destination.

Print next
If you want to upgrade a job in the queue to be printed immediately after the currently printing job, select the 
desired job and tap the Print next button.

Print now
If you want to upgrade a job in the queue to be printed immediately, interrupting the currently printing job, select 
the desired job and tap the Print now button.

92 Chapter 6   Queue management ENWW



NOTE: To enable this action, tap  in the home screen, then Job management and activate Enable print 

now.

See job details
Tap the name of the job to show its details in the right pane, including information about status, pages, copies, 
total, and preview. Scroll down as necessary to see all of the information.

By tapping the thumbnail, you can navigate over all pages of the job. Use the … to show or hide the toolbar. From 
there you can zoom in and out and see more information about each page.

Roll policies
If two rolls are loaded, both of which are suitable for the job, the roll is chosen according to your preferences.

● Increase productivity: To increase the productivity of the printer.

– Job autorotation: The printer can rotate a job automatically in order to save paper.

● Automatic roll selection: When the job arrives with the roll not defined, the printer selects the rolls 
according to the following settings.

– Roll width selection: The printer can be more or less restrictive when selecting the roll width on which 
to print. You can select to print on the same width only (each page prints on a roll with same width as 
the page) or to print on the same width or wider (each page prints on roll with same width as the page 
or wider).

– Avoid printing on a wider roll: Avoid switching to a wider roll when the defined rolls are depleted. Only 
applies when Roll width selection is Print on same width or wider.

– Use most depleted roll: When there are two or more rolls with the same paper type and width, the roll 
selected is the roll with less paper.

– Paper type protection: You can avoid printing accidentally on special paper types by protecting them. 
Protected types are eligible for printing only when paper type or roll are specified in the job.

Solve paper mismatch
If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can 
automatically solve the conflict or give a number of choices depending on the printer policies. Such a conflict may 
be caused by a job sent to the printer with no specific roll or paper type assigned to it, or by a roll coming to its 
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end during printing. The following options are available in the paper mismatch settings menu; you can reach this 

menu from the job queue by tapping  , then Mismatch actions; or by tapping  , then Job management 

> Mismatch actions.

● Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This option is 
recommended when the printer is attended. A message appears, asking what you want to do: cancel the 
job, print anyway, put on hold, or load paper. These options are also available in the job queue.

● Hold job and continue with next: Put mismatched jobs on hold until the correct paper is loaded, and 
continue printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. This 
option is recommended when the printer is unattended, even though the integrity of a job may be 
disrupted, to avoid stopping the queue. Once the paper required for the job is loaded, the job or pages are 
automatically resumed.

● Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose the roll 
to print according to the following criteria: first where the page fits and then the same paper type. This 
option will never select a paper type that has been protected.

Solve output mismatch
The selected output for a particular job is not available for some reason: output disconnected, detached, full, not 
empty for a job that requires it to be empty, size/type/length not supported by that output, or folder is offline. 
The following options are available in the paper mismatch settings menu; you can reach this menu from the job 

queue by tapping  , then Mismatch actions; or by tapping  , then Job management > Mismatch actions.

● Put jobs on hold: Put mismatched jobs on hold until the correct output is available, and continue printing 
the rest of the job queue. The printer sends an alert whenever a job is put on hold. This option is 
recommended when the printer is unattended, to avoid stopping the queue.

● Pause job queue and ask: Printing stops until the correct output is available. This option is recommended 
when the printer is attended. A message will appear asking what you want to do: cancel the job, print 
anyway, put on hold, or load paper.
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Job queue options

To change the job queue options, tap  , then Job management > Job queue.

You can select the maximum number of printed jobs to have in the queue, when to delete printed jobs, and 
whether to delete jobs on hold after a specified time.

When to start printing
You can choose whether the printer starts printing after all pages of a job have been rendered, or earlier, while 

some pages are still being rendered. To change this option, tap  , then Job management > When to start 

printing.

If you select Print after processing, the printer starts printing after all pages of the job have been rendered by the 
printer's internal processor. The printer will take more time to start printing but is less likely to pause while 
printing. This is the recommended setting when:

● You are using HP SmartStream to submit jobs

● Your job contains pages of high complexity

● Your job has multiple collated copies

● The printer queue contains multiple jobs

● You are sending a multipage or multicopy job with the cutter disabled (Cutter off in multi-page job)

NOTE: Even if you select Print after processing, the printer may pause during a job if it is very long or contains 
pages of high density.

If you select Optimized printing mode, the printer starts printing before all pages have been rendered. The 
printer will take less time to start printing but is more likely to pause while printing. This is the recommended 
setting when your job contains many pages and you want to receive the first pages as soon as possible. This 
option may increase overall printing speed if:

● Your jobs contain pages of low or medium complexity

● Your jobs have multiple non-collated copies of every page

NOTE: When a page has been printed once, that means that it has been fully rendered, so further copies 
of the same page can be printed without pauses for rendering.

NOTE: Even if you select Optimized printing mode, the printer may wait until all pages have been rendered in 
the following cases:

● You have asked the printer to print First page on top

● You submitted the job from an HP printer driver or from some RIPs

● You are printing by direct copy
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If you are printing while scanning (in copy mode), and want to start printing before all pages are scanned, select 
the following options:

● Optimized print mode

● Collate off

● First page on top if using the top stacker, otherwise Last page on top.

Remember to tap Finish in the scanner menu to close the scan session.

Default printing preferences

At the front panel, tap  , then Default Printing configuration to define the default properties of jobs sent to 

your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, HP-GL/2, PostScript, Print 
retrieval.

NOTE: In the paper options you can define settings such as the default size and rotation. This kind of setting 
can be modified for each job by driver, HP SmartStream, quickset, and so on. But the mirror option is not 
available in HP SmartStream or quickset; so, if it is activated, all jobs printed by any path, except from the printer 
driver, will be affected.

If the print is mirrored, check the status of this setting: Default printing configuration > Paper option > Mirror 
image.

Job deletion
If the printer runs out of storage space for new jobs, the oldest printed jobs are automatically deleted from the 
queue.

You can request that printed jobs should be automatically deleted from the queue when the total number of 
printed jobs exceeds a specified limit (the maximum number in the history setting), or when the jobs were 
printed more than a specified time ago (clear history settings).

To delete jobs on hold, the setting Delete jobs on hold allows you to define the time after which these jobs will be 
removed (2–48 h).

To delete a job manually, select the job and tap Delete in the footer. To delete all jobs, tap Delete all jobs in the … 
menu; the whole job queue will be deleted.

The delete option deletes the job from the queue, while the cancel option cancels the job but leaves it in the 
queue, marked as Canceled by the user in the history category.

To cancel a job, tap the job name on the list and then tap Cancel job at the bottom right. If you are not in the job 
queue screen, you can cancel a job while printing by tapping X.

NOTE: If you tap X, you cancel the currently printing job only.
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Job queue in the Embedded Web Server
You can access the Embedded Web Server from any computer with an Internet connection, by entering the IP 
address of the printer in your Web browser; the job queue is shown by default in the first window that appears.

The Embedded Web Server can show up to 32 jobs. The filename, status, and time of creation are shown for 
each job; there is no job preview.

Available functions

● Cancel: Cancel a job, even if it is already printing.

● Reprint: Reprint a job, with the same settings as before, except that you can change the number of copies.

● Hold: Put on hold a job that was sent to print.

● Resume: Release for printing a job that was previously put on hold.

● Refresh: Update the list of jobs (it does not update automatically).

NOTE: If the admin account has been activated, you can see the job queue but you must give the password to 
perform any of these functions.

TIP: If the job queue does not appear, you may need to clear the browser cache.
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7 Collection and finishing

If you choose no specific job destination, prints are sent to the default output destination, which can be changed 

from the front panel. From the home screen, tap  , then Output destination.

● Top stacker 

● High-capacity stacker 

● HP folders 

● Basket 
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Top stacker

The top stacker is available as an accessory.

It can accommodate up to 100 sheets of paper, depending on the paper type and size.

When stacking Natural Tracing Paper, use the supports attached to the top stacker (not recommended for other 
paper types).

By default, the printer cuts the paper after every printed page, and the resulting sheets of paper are neatly 
stacked by the stacker.

If you send pages longer than 1.2 m (4 ft) to the stacker, you are recommended to stand by the stacker to 
prevent the prints from falling on the floor.

You can retrieve part of the stacker pile by waiting until the current job finishes, or by pausing the current job.

After retrieving sheets from the stacker, do not return them to the stacker or put them on top of the stacker, 
which can cause a paper jam.

To use the stacker, select it as follows before sending the job to print:

● Front panel: Tap  , then Output destination > Top stacker.

● Printer driver: Go to the printer properties, select the Layout/Output tab, and change the output destination 
to Top stacker.

● HP SmartStream: Set the destination to Top stacker, in the job preparation pane or in the settings pane.

The printed job is automatically collected by the top stacker. Wait until the job has finished, then collect the 
output.
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NOTE: During normal use, you do not need to do anything with the stacker except to remove the stack of 
printed paper. Occasionally you will need to open the top cover to access the printheads for replacement (see 
Replace printheads on page 61), and you may need to take action to clear a paper jam (see Paper jam in the top 
stacker on page 46).

Stacker status in the front panel

● Ready: Ready to receive prints.

● Error: Hardware malfunction, paper jam, and so on. Jobs are put on hold or paused for output, depending 
on the policy selected.

● Open: The rear arm, the front tray, or the cleanout is open (you should close whichever is open). Jobs are 
put on hold or paused for output, depending on the policy selected.

● Full: The stacker is full. Jobs are put on hold or paused for output, depending on the policy selected.

NOTE: Some types of paper, such as curled paper, can cause jams in the stacker. For that reason, the 
stacker may report itself as full when stacking pages coming from the end of a roll.

● Collection required: To avoid problems due to the characteristics of some papers, in some cases you may 
need to collect printed jobs to continue printing.

High-capacity stacker

The high-capacity stacker is available as an accessory.

By default, the printer cuts the paper after every printed page, and the resulting sheets of paper are neatly 
stacked by the stacker.

The stacker can accommodate 500 plain paper sheets of A1 or A0 size at 80 g/m². Its capacity for different paper 
types or sizes may be lower, depending on density and weight. It can handle all paper types accepted by the 
printer.

The accessory roof should be horizontal, unless you are printing on natural tracing paper, in which case you 
should put the roof into its vertical position.

Printed pages are stacked face up and in reverse order with respect to the order of the pages in the document 
sent (if multipage). To change this order, use the setting First page on top in the submission software.

If the printer is printing at full speed, it will take about 20 minutes for the stacker to fill up with paper. You can 
pause the job queue from the job queue application, if you want to collect part of the job before it finishes.

If you send pages longer than 1.5 m (5 ft) to the stacker, you are recommended to stand by the stacker to 
prevent the prints from falling on the floor.
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IMPORTANT: The stacker will not work unless it is connected to the printer.

1. To use the stacker, select it as follows when sending the job to print:

● Front panel: Tap  , then Output destination > High-capacity stacker.

● Printer driver: Go to the printer properties, select the Layout/Output tab, and change the output 
destination to High-capacity stacker.

● HP SmartStream: Set the destination to High-capacity stacker, in the job preparation pane or in the 
settings pane.

TIP: Enable Separator in the HP SmartStream job options to print a separator page between jobs.

2. The printed job is automatically collected by the stacker. Go to the rear of the printer, wait until the job has 
finished, and collect the output.

TIP: You are recommended to pause the job queue if you want to retrieve part of a job from the stacker.

Status in the front panel

● Ready: You can use the stacker.

● Full: Unload the stacker before sending more jobs.

● Paper jam: Follow front-panel instructions to clear the jam.

● Error

Follow the instructions on the front panel to fix the error. If the problem persists, contact your support 
representative.

If you have a high-capacity stacker output error, you can uninstall the stacker (at the front panel, tap the 
paper app, then Output > Settings > Uninstall) and continue printing to another destination. Otherwise, you 
cannot continue printing to any destination until the error is solved.

NOTE: If you later reconnect the stacker without having changed it, the complete install process is not 
needed. 

● Detached. Stacker is offline.

You may sometimes separate the stacker from the printer to clear paper jams in the printer. In that case, 
the front panel warns you that the stacker is separated, the printer puts all jobs on hold, and displays the 
message Output is now detached from printer. Please reposition. You cannot print until the stacker is 
mechanically reconnected.

HP folders

HP F60, HP F70, and HP PageWide Folders
The HP folders fold printed sheets of paper, managing the printed sheet from end to end. They support roll sizes 
up to 36 in (914 mm) wide, with multiple folding styles, and can handle paper weights from 75 to 90 g/m².
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You can choose the cross-fold or fan-fold tray; or, if you do not want to fold the sheets, you can choose to stack 
them in the no-fold tray.

1. The cross-fold tray collects folded pages. The tray holds up to 150 A0 folded sheets. They may be up to 
914 mm (36 in) wide and up to 2.5 m (98 in) long. Longer sheets are not transported into the cross-folder 
but deployed fan-folded in the catch tray under the no-fold tray.

2. The fan-fold tray holds five to ten long pages. The tray can handle all sheet sizes from 210 mm (8.5 in) to 6 
m (19.6 ft) long (80 g/m² paper), or longer with an extra-length license (an option), and width up to 914 
mm (36 in). Long sheets are deployed fan-folded in the catch tray under the no-fold tray.

3. The no-fold tray is used for stacking unfolded pages, up to around 10 sheets. It can handle A1 landscape or 
A0 sheets; maximum width 914 mm (36 in). Prints that should not be folded will be deployed onto the top 
of the no-fold tray.

Submitting a job to the folder

NOTE: While the folder is installed, it is the printer’s default output device. If you submit a job without specifying 
a folding style, the default style is applied. You can tap  to change the folder settings or default folding styles.

NOTE: If you want to stack jobs in the folder without folding them, select Not folded as the folding style.

NOTE: In most cases the title block (legend) should be on the leading edge of the document entering the folder. 
The title block position has to be set in the printing software you are using (by rotation if necessary).

To use the folder, select it as follows when sending the job to print:

● Front panel: Tap  , then Output destination > Folder.

When printing from a USB flash drive, or copying, you will be able to select the folder as the output 
destination and select the folding style.
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● Printer driver: Go to the printer properties, select the Layout/Output tab, and change the output destination 
to Folder.

The first time you use the folder, you must specify the folding styles that you expect to use. To do that, go 

to the front panel and tap  , then Output destination > Printing from driver; from there you can 

assign one folding style to each predefine.

Then, in the printing dialog, you will be able to select each predefine or the default.

Recommended settings for folding jobs:

● Clip content by margin: To avoid printing in the margins and fold properly. From the Paper/Quality tab, 
click Margins/Layout > Clip content by margin.

● Right-alignment: To ensure that the block title is in the correct position when folding. Select this in the 
Layout/Output tab.

● Portrait orientation: Select this in the Layout/Output tab.

There are some paper types that are not supported by the folder. You will see a warning if you try to send 
such a paper type to the folder.
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● HP SmartStream: Set the destination to Folder, in the job preparation pane or in the settings pane. You can 
also select the folding style.

You can specify in the application preferences whether you want to see the dimensions of the folded paper 
indicated in green in the preview.

NOTE: The folded dimensions are not shown if they are unknown at this point.
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The green rectangle in the preview indicates which part of the page will be on top after folding. If the page 
contains some header or summary information describing its contents, you may want to ensure that this is 
in the green rectangle, so that it will be easily visible once the page has been folded. To move the contents 
of the page, you can use the rotation, alignment, and/or margins options (among the paper source options 
in the settings pane).

The following steps are recommended to check that the required content is in the green rectangle, and to 
adjust the page if necessary:

1. Set the default alignment between pages and roll in the preferences so that the page is placed on the 
correct side of the roll. You need to do this only once.

2. Select the first page of the job to see it in the preview.

3. Zoom in on the green rectangle. You may want to maximize the preview.

4. If required, use the E key on the keyboard to rotate the page 90° counterclockwise or the R key to 
rotate 90° clockwise.

5. Use the down-arrow navigation key to select and preview the next page.

Folder status
● Starting: The folder is initializing and not yet ready.

● Ready: The folder is ready to receive jobs, waiting for jobs, or receiving jobs.

● Full: The cross-fold or no-fold tray has reached its full capacity. The printer finishes the current page, then 
stops printing.

● Error. In these cases, all jobs are put on hold for output.

– Paper jam

– Cover open

– Folder not attached

– Communication error (the cable is connected but there is no communication)

– Tab applicator empty (if a job is to be folded with tabs)

● Offline folding active

● Disconnected (the cable is not connected)

Folder status LED
● White: Ready

● White blinking: Working

● White/yellow blinking: Out of tabs

● Red: Error, needs attention (may be full)
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Folding styles
The folder can fold pages in two different ways:

● Fan fold, in which folds are perpendicular to the printing direction

● Cross fold, in which folds are parallel to the printing direction

Folding styles are usually based on DIN B or DIN C style:

DIN B

The top and bottom folds are always on opposite sides. If this is what you want, select a 
folding style below marked with an asterisk, as these are the ones based on DIN B style. All 
folding styles that include a filing option (tab or filing margin) need to follow that 
configuration. It requires compensation folds in many formats since the last page’s end 
needs to be in a certain position for the filing option (hanging strip/filing margin). As those 
packets have more, unevenly distributed, folds, they tend to be thicker on one side making 
them topple over when you pile them up. Furthermore, the stack gets bigger.

DIN C

The top and bottom folds are not necessarily on opposite sides. There are no 
compensation folds, which means that you are getting a thinner and more even stack 
when plotting a lot of prints and keeping them in one stack, either in plastic jackets or in 
envelopes/ folders.

DIN

● DIN A 190+20 × 297 mm (with binding edge)*

190 mm width, 20 mm margin, 297 mm height

● DIN B 210 × 297 mm (back panel covered)*

210 mm width, 297 mm height
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● DIN B 198 × 297 mm TAB*

198 mm width, 297 mm height, with tabs

● DIN B 210 × 297 mm TAB*

210 mm width, 297 mm height, with tabs

● DIN C 210 × 297 mm (compact fold)

210 mm width, 297 mm height

● DIN B 210 × 305 mm*

210 mm width, 305 mm height

AFNOR (HP F60, HP F70, and HP PageWide XL folders only)

For AFNOR style, use DIN format rolls. Jobs should be submitted as A0 portrait, A1 landscape, or A3 landscape.

● AFNOR (297 × 210 mm)

297 mm width, 210 mm height
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ANSI

● ANSI 7.5 + 1 × 11 in

7.5 in width, 1 in margin, 11 in height

● ANSI 8.5 × 11 in

8.5 in width, 11 in height

Fan fold only

● Fan fold only (210 mm)

● Fan fold only 9 in

Others

● 185 + 25 × 297 mm (with binding edge)

180 mm width, 25 mm margin, 297 mm height

● ARCH 9 × 12 in

9 in width, 12 in height
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● Mailer 7.5 × 10 in

7.5 in width, 10 in height

● Inverse DIN (210 × 297 mm)

210 mm width, 297 mm height

The title block will be shown as follows when unfolded:

For the full list, see the front-panel menu at the default Folding style selection.

TIP: The folder tries to compensate automatically if the sheet width is exceeded. If the compensation is not 
successful, try choosing the DIN B 210 × 305 mm folding style.

There are other functionalities available for purchase. For more information, contact your support representative.

Tab applicator (HP F60, HP F70, and HP PageWide XL folders only)
● When available, a folding style with tab application can be selected from HP SmartStream, the printer driver, 

USB flash drive, or Copy.

● During installation or replacement, you are asked how many tabs are in the roll. See Replace the folder’s 
tab reel on page 122.

● The message Folder out of tabs is displayed when the folder runs out of tabs, and jobs with tab are put on 
hold.

Block title
The diagram below shows where the block title should be placed according to page size, folding style, and 
printing direction.
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Ansi Architectural Iso Afnor

E: 44 34 inches E: 48 36 inches A0: 1189 841mm A0: 841 1189mm

D: 34 22 inches D: 36 24 inches A1: 841 594mm
A1: 841 594mm

C: 22 17 inches C: 24 18 inches A2: 594 420mm A1: 420 594mm

B: 17 11 inches B: 18 12 inches A3: 420 297mm A3: 420 297mm

Offline folding (HP F60, HP F70, and HP PageWide XL folders only)
Offline folding means that you provide the printed sheets to the folder manually: they do not come directly from 
the printer. The default folding style is used.

1. In the Output menu, tap Offline fold. The job queue is automatically paused.

2. Empty the no-fold tray if there are any jobs stacked there.

3. Insert the first sheet face down, with the title block leading.
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4. Move the tray to the center. The insertion rail on the table can be slid into the best position for the 
document you are inserting.

5. Go to the job queue and release it.

Troubleshooting
● Jams: If a paper jam is detected, the front panel will notify you. See Paper jam on page 40.

● Calibration: If you notice that folded jobs are not well aligned on the folding edge, or there is more skew 
than expected, the folder may not be calibrated. Contact your support representative.

● Communication problems: If the printer does not recognize the folder, try to switch off the printer and 
folder. Disconnect the communication cable, make sure the bridge is attached, then start both printer and 
folder separately. Once both systems are up and ready (the folder LED should be blue), connect the 
communication cable and wait for the folder to switch to online (the folder LED should be white). If the 
problem persists, contact your support representative.

How to improve productivity
● Use portrait orientation.

● Use DIN or AFNOR folding styles for metric rolls (A0, A1, A2, A3, and A4).

● Use ANSI folding styles for imperial rolls (36 in, 24 in).

Basket
The basket serves as a secondary output path, mainly collecting waste and pages that cannot be sent to other 
destinations.

You can use the basket, for example, if other destinations are full, or if you want to separate a job from others.

After sending a print of A0/E size or greater to the basket, you must collect the print in order to continue printing.

If you send long pages to the basket, you are recommended to stand by the printer to prevent the prints from 
falling on the floor or causing jams.

The illustration below shows the basket ready for use.
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The illustration below shows the basket closed, permitting easier access to the printer (to clear printer jams, for 
example).

NOTE: If the basket is the selected output device, do not try to print with the basket closed.
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8 Print quality

● General printing advice

● Optimize print quality app

● Print diagnostic plot 

● Advanced options

● Enhanced printhead recovery 

● Page length accuracy 

● Manual printhead alignment 
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General printing advice
When you have any print-quality problem:

● To achieve the best performance from your printer, use only genuine manufacturer's supplies and 
accessories, whose reliability and performance have been thoroughly tested to give trouble-free 
performance and best-quality prints.

● Make sure that the paper type selected in the front panel is the same as the paper type loaded into the 
printer. At the same time, check that the paper type has been calibrated. Also make sure that the paper 
type selected in your software is the same as the paper type loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printhead.

● Check that you are using the most appropriate print-quality settings for your purposes (see Select print 
quality on page 88).

● Check that your environmental conditions (temperature, humidity) are in the recommended range for 
printer and paper.

● Check that your ink cartridges have not passed their expiration dates and are in good condition.

● Check the printhead status.

● If you have any pending calibration for a paper type, tap Calibrate Print Bar.

If you still experience print-quality problems, you can follow a more hands-on print-quality troubleshooting 
procedure, by printing, interpreting, and performing corrective actions as follows.

Optimize print quality app
Go to the optimize print quality app in the front panel to see the different options available.
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Print diagnostic plot
Tap the Print diagnostic plot button to identify the problems you may have.

Use the same paper type that you were using when you detected a problem, and check that the selected paper 
type is the same as the paper loaded into the printer.

The print is divided into three parts. The top part is about print-bar and color calibration problems, the center is 
about alignment problems, and the bottom part is an illustration of the printhead positions that can be used as a 
reference.

Check and recover print bar
If you detect problems in the top part of the plot, where there are random (not regular) lighter, very thin lines, 
some printheads may need cleaning. Tap Check and recover print bar.

The time required depends on the number of printheads to be cleaned. Once they have been cleaned, reprint the 
diagnostic plot to check that the problem has been solved. Allow 10 minutes per printhead.

If the problem persists, check in the diagnostic plot for which printhead the defects appear. You can identify 
which printhead has the problem from the numbered printhead image on the bottom of the top part. To clean 
only that printhead, tap Enhanced printhead recovery (see Enhanced printhead recovery on page 118).
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Calibrate print bar   
Color variation in the bands in the top part of the plot indicates a possible problem in the color calibration.

The central part of the plot indicates whether the print bar is correctly calibrated. The vertical lines indicate the 
boundaries of the different print elements within a printhead (die boundaries). In the horizontal gray band, no 
repetitive white lines or dark lines should be seen above the die boundaries. The horizontal lines of different 
colors should be continuous and not broken or jagged at the die boundaries; if this occurs, a printhead alignment 
is required.

If you see defects, you should calibrate the printer by tapping Calibrate print bar in the optimize print quality app. 
You should also calibrate the printer if you are warned that a roll has a calibration pending status.

Print-bar calibration includes printhead alignment and color calibration.

You can check what calibrations have been done in the past by tapping the Calibration history button; and you 
can restore the original factory calibrations at any time.

NOTE: Make sure that the room temperature during calibration is similar to the temperature during normal 
printing. Big temperature differences (> 10°C) can affect the calibrations.

NOTE: Some paper types cannot be calibrated.
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Calibration procedure

1. Tap Calibrate print bar, then Continue.

2. Make sure that you have loaded a roll of HP Production Matte Polypropylene, 40 in (1016 mm) wide, for 
best results and least waste.

NOTE: You are highly recommended to use HP Production Matte Polypropylene, 40 in (1016mm) wide, to 
calibrate the print bar.

If you don't have this paper type, or uniform color is not very important to you (such as when printing only 
CAD drawings), you can disable color calibration to shorten calibration time and paper usage, by tapping 
and checking the box Only printhead alignment in the optimize-print-quality settings. Thereafter, the 
printer will perform only alignment when this routine is launched. In that case, you can run the print-bar 
calibration using a different paper type.

If do not use the widest roll that you have, some rolls may remain uncalibrated and the printer will ask for 
extra calibrations later.

3. Color calibration takes about 12 minutes and uses about 1 m (39 in) of paper.

4. Printhead alignment takes about 12 minutes and uses about 1.3 m (51 in) of paper.

5. After the calibration, the printer uses the results to calculate calibrations for all other paper types.

If the print-bar calibration fails with an error message or leaves some dies misaligned, print the Diagnostics Plot 
and make sure there are no large contiguous groups of missing nozzles. If there are large contiguous groups of 
missing nozzles, follow the printhead recovery procedure.

Select all

By checking the Select all box, you can do both basic routines: check and recover the print bar, and calibrate the 
print bar. This can be useful when these routines have not been done for a while, or if you are unsure which 
routine is appropriate.

Advanced options
You can go to Advanced options to run specific custom calibrations to solve particular kinds of problems.
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Enhanced printhead recovery
This procedure aims to recover a printhead that has been degraded by heavy usage, or when other methods 
have failed. It is an intensive procedure to recover printheads with severe degradation, such as multiple nozzles 
malfunctioning, or color mixing. It may also be used to optimize printheads for jobs with high ink coverage. See 
Check and recover print bar on page 115.

NOTE: First print a diagnostic plot to identify which printheads require cleaning and thus avoid waste of ink. You 
can select particular printheads for enhanced recovery. In the example below, the affected printhead would be 
number 3.

Page length accuracy
If you find that printed page lengths are slightly incorrect, go to the print quality app and tap Page length 
accuracy.

The next screen shows the loaded paper types. Select the one you need to correct automatically or manually. If 
you select Start (recommended), the printer makes an automatic correction. The front panel warns you to allow 
some time and paper for the correction. If you select Adjust manually, you must enter the value of the length 
error.

For example, you may print an A0 (1189 mm) page, but you measure the print and find that its length is 1187 
mm. You should select A0 and a measured page length of 1187 mm. The page length correction is automatically 
updated to +2 mm when you enter the measured value.

IMPORTANT: You could cause a system error or damage to the printer by entering an incorrect error value after 
Adjust manually.

If the above procedures do not solve your problem, call your support representative.
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Manual printhead alignment
Manual printhead alignment is a calibration that works on top of the automatic alignment run during the print 
bar calibration (Optimize print quality menu). The aim of this calibration is to fine-tune the overlap between the 
different printheads and printing areas in order to remove white/dark lines.

TIP: Some defects may appear on some specific paper types only. You may be able to achieve better results in 
some cases by changing your paper type.

TIP: In some cases, Calibrate print bar by itself may be enough to correct defects. If not, try manual printhead 
alignment.

TIP: However, if the results after manual printhead alignment are not satisfactory, you can use Calibrate print 
bar to restore automatic alignment.
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9 Maintenance

● Check printer status 

● Clean the exterior of the printer 

● Move or store the printer 

● Move or store the high-capacity stacker 

● Move or store the folder 

● Replace the folder’s tab reel 

● Update the firmware 

● Secure File Erase 

● Disk Wipe 
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Check printer status
You can check the current status of the printer in various ways:

● If you start the HP Utility and select your printer, you see a page of information describing the status of the 
printer and its paper and ink supplies.

● If you access the Embedded Web Server, you see information about the general status of the printer. The 
Supplies page in the Main tab describes the status of the paper and ink supplies.

● At the front panel, you can see information about paper, ink levels, ink cartridges, and printhead by tapping 
its corresponding icon.

● At the front panel, If there are any current alerts, the upper row of the home screen shows the top-priority 
alert. Tap this message to see a list of all current alerts, with an icon indicating the severity of each alert. 
You can tap an alert to get help in solving the problem.

● From a distance, you can get a quick idea of the printer status by looking at the beacon. See Printer alerts 
on page 9.

Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal 
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean 
it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Move or store the printer 
IMPORTANT: If the printer needs to be shipped to a different location, you should contact your reseller for 
assistance. The printer has sensitive components that can be damaged during transportation: special 
transportation features and tools are needed.

To move your printer or store it for an extended period of time at the same site, prepare it correctly as follows to 
avoid possible damage. Move the printer on its own wheels only over smooth, flat surfaces and do not attempt 
to go up or down steps.

1. Do not remove the ink cartridges, maintenance cartridge, or cleaning container.

2. If you are moving the printer to a different location, remove the printheads and store them in the containers 
provided for the purpose.

3. Make sure that no paper is loaded in any drawer.

4. Turn off the power using the Power key on the front panel.

5. Also turn off the power switch at the rear of the printer.

6. Disconnect any cables connecting the printer to a network, a computer, a scanner, or any other accessory.
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7. Never turn the printer upside down or on its side.

8. For correct environmental storage conditions, see Environmental specifications on page 141.

NOTE: The printheads have their own environmental specifications, separate from those of the printer. 
However, they are best stored in the printer.

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid location, water from 
the atmosphere can condense on the printer parts and cartridges and can result in ink leaks and printer errors. In 
this case, HP recommends that you wait at least 3 hours before turning on the printer or installing the ink 
cartridges, to allow the water to evaporate.

Move or store the high-capacity stacker 
Move the high capacity stacker on its own wheels only over smooth, flat surfaces and do not attempt to go up or 
down steps.

A minimum door or corridor width of 130 cm is required when moving the high-capacity stacker. If the tray needs 
to be disassembled to pass through doors or corridors, call your support representative. This should be done by 
trained service personnel.

Disconnect the cable before moving or storing the stacker. Reconnect the cable before using the stacker again.

If you will be using the stacker again with the same printer, its height does not need to change. If you attach it to 
a different printer, you may need to adjust the height. To adjust the height, turn the screw clockwise (as shown 
below) to move the stacker up, or counterclockwise to move it down. Then connect the stacker to the printer.

NOTE: There is a line in the center of the printer and another in the center of the stacker to help you.

Move or store the folder 
Move the folder on its own wheels only over smooth, flat surfaces and do not attempt to go up or down steps.

Disconnect the cable before moving or storing the folder.

Before using the folder again, adjust its height and reconnect the cable.
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Replace the folder’s tab reel
Example video of a folder with tabs

1. Open the door.

2. Pull the lower lever.

Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

3. Rotate the tab protector to remove it.
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Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

4. Remove the empty tabs.

Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

5. Place the new tab reel.

Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

6. Put back the tab protector.
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Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

7. Pull the upper lever.

Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

8. Pass the tab reel.

Illustration for folder with part number L3M58A

Open the two parts as shown to pass the tab reel

Illustration for folder with part number L3M58B

Pass the tab between the wheels

9. Pass the tab reel by the path shown in the image.
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Illustration for folder with part number L3M58A Illustration for folder with part number L3M58B

10. Folder with part number L3M58A only: Close the two parts that you opened in step 8.

11. Push back the two levers.

Illustration for folder with part number L3M58A
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Illustration for folder with part number L3M58B  

12. Close the door.

NOTE: If you have asked for tabs but they do not appear on the folded jobs, open the cover and check that they 
are properly installed and that no problem has occurred. 

Update the firmware
The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer's functionality, 
enhance its features, and may correct minor problems.

IMPORTANT: You are strongly recommended to update the firmware periodically in order to take advantage of 
the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you find most 
convenient. They can be divided into two categories: automatic and manual updates.

NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets can be 
downloaded separately.
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Automatic firmware updates
Automatic firmware updates are a convenience that is possible with HP-connected printers. Your printer can 
automatically download the latest firmware release and install it for you.

Important notes

● Your printer must be connected to the Internet; see Configure your connectivity on page 18.

● To configure automatic firmware updates, you can use the front panel or the Embedded Web Server; see 
Configure your connectivity on page 18.

● A firmware update package can be large; you may want to consider whether there are any implications for 
your network or Internet connection.

● A firmware update is downloaded in the background: the printer can be printing at the same time. However, 
it cannot be installed in the background: printing must stop.

Manual firmware updates
Manual firmware updates can be performed in the following ways:

● Using the Embedded Web Server, click the Setup tab and then Firmware update. Click Browse to select a 
firmware file (.fmw) that you have already downloaded to your own computer.

● Using the HP DesignJet Utility under Windows, click the Admin tab and then Firmware Update.

● Using the HP Utility under Mac OS X, click Firmware Update.

● Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic updates.

● Using a USB flash drive: Download the firmware file from http://www.hp.com/go/pagewidexlseries/
support/firmware/ (according to your printer model) into the USB flash drive and insert it into the Hi-Speed 
USB host port in the front panel. A firmware update assistant will appear on the front panel to guide you 
through the update process.
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Secure File Erase  
The printer's hard disk is used as a temporary storage area for print jobs. Secure File Erase can erase your 
temporary files from the hard disk to protect them from unauthorized access. It begins to do so as soon as you 
turn it on, but old temporary files that were already on the hard disk are not erased retroactively. If you want to 
erase the old files too, see Disk Wipe on page 129.

Secure File Erase provides three different levels of security:

● Non-Secure: all pointers to the information are erased. The information itself remains on the hard disk until 
the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the 
disk, it is difficult for most people to access, but may be accessed using software designed for the purpose. 
This is the normal method in which files are erased on most computer systems; it is the fastest method but 
the least secure.

● Secure Fast Erase (1 pass): all pointers to the information are erased, and the information itself is also 
overwritten with a fixed character pattern. This method is slower than Non-Secure, but more secure. It may 
still be possible to access fragments of the erased information by using special tools to detect residual 
magnetic traces.

● Secure Sanitizing Erase (5 passes): all pointers to the information are erased, and the information itself is 
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest 
method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m 
requirements for clearing and sanitization of disk media. This is the default security level when using 
Secure File Erase.

While files are being erased, the printer's performance may be affected.

Secure File Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print 
management software: see http://www.hp.com/go/webjetadmin.

If you have difficulty in using Secure File Erase from Web JetAdmin, contact your support representative: see 
When you need help on page 132.

The Secure File Erase configuration can be changed from Web JetAdmin or the Embedded Web Server (Setup > 
Security).

Disk Wipe
Disk Wipe is the same as Secure File Erase (see Secure File Erase on page 129), except that it erases all 
temporary files, including old ones.

The Disk Wipe configuration can be changed from Web JetAdmin or the Embedded Web Server (Setup > 
Security).

NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several times during 
the process, which will take about 6 hours with Secure Fast Erase or 24 hours with Secure Sanitizing Erase.
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10 Accessories

How to order
Contact your support representative (see When you need help on page 132), and check that what you want is 
available in your area.

The rest of this chapter lists the available supplies and accessories, and their part numbers, at the time of 
writing.

List of accessories
● HP SmartStream software

● HP DesignJet SD Pro 44-in Scanner (G6H50B)

● HP DesignJet HD Pro 42-in Scanner (G6H51B)

● HP PageWide XL PostScript/PDF Upgrade Kit (CZ317A)

The PostScript upgrade enables the printer to print PDF and PostScript files. The PostScript upgrade can be 
plugged into the printer's USB host port. It is not necessary to leave it permanently connected: just plug it in 
once, and the printer is upgraded forever.

● HP PageWide XL Drawer (CZ318A)

● HP PageWide XL High-Capacity Stacker (CZ319A)

● HP PageWide XL Top Stacker (CZ320A)

● HP PageWide XL Folder with Tab Applicator (L3M58A)

● HP F70 Folder (K5H75A)

● HP F70 Folder with Tab Applicator (L3M58B)

● HP F60 Folder (1EW99A)

● HP F60 Folder with Tab Applicator (1EX00A, 1EX00B)

● HP F60 Folder with Tab Applicator (1EX00H)

● HP PageWide XL Folder Upgrade Kit for Long Plots (M0V04A)
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Non-HP accessories

Install

To install a non-HP accessory, tap  , then Output destination > Install non-HP accessory.

NOTE: Before installing the non-HP accessory, make sure it is connected to the printer (with cable and hooks) 
and switched on.

Configure
The following settings are available:

● Minimum gap between sheets. Range from 100 to 3000 milliseconds.

● Maximum supported speed. Range from 2 to 15 inches per second.

● Minimum page length supported. Range from 180 to 1000 millimeters.
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11 When you need help 

● Request support

● Customer Self-Repair 

● Service information 
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Request support
Support is provided by your support representative: usually from the company from which you bought the 
printer.

Before calling your support representative, prepare for the call as follows:

● Review the troubleshooting suggestions in this guide.

● Review your software documentation, if relevant.

● Check that you have the following information ready:

– The product and serial numbers of the printer you are using.

– If there is an error code on the front panel, make a note of it. See Front-panel error messages 
on page 143.

– The name and version number of your software.

– If you have a print-quality problem, the name and product number of the paper, and the name and 
origin of the paper preset that you used to print on it.

Customer Self-Repair 
HP's Customer Self-Repair program offers our customers the fastest service under either warranty or contract. It 
enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this 
program, you can replace parts at your own convenience.

Convenient and easy to use

● Your support representative will diagnose and assess whether a replacement part is required to address a 
defective hardware component.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair/.

Service information
The printer can produce on request a list of many aspects of its current status, some of which may be useful to a 
service engineer trying to fix a problem. There are two different ways to request this list:

● In the Embedded Web Server (see Embedded Web Server on page 13), click the Support tab and then 
Service support > Printer information. You are recommended to request the whole list (click All pages).

● From any computer with Internet access, enter the URL of your printer into a Web browser, followed 
by /hp/device/webAccess/allServicePlot.htm. For instance, if the URL of your printer is 
http://123.123.123.123, enter:

http://123.123.123.123/hp/device/webAccess/allServicePlot.htm

If you need to send the list by email, you can save the page as a file from your Web browser, and later send the 
file. Alternatively, from Internet Explorer you can send the page directly: click File > Send > Page by email.
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12 Retrieving printer usage information

● Get printer usage and accounting information 

● Get usage information 

● Get detailed job accounting information
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Get printer usage and accounting information
There are two types of information you can get related to printer usage:

● Accumulated usage information: information about printer usage (paper and ink consumption) and scanner 
usage (scan and copy) for the whole life of the printer.

● Detailed job accounting information: information about the characteristics of specific scan and print jobs, 
such as who created it, when it was sent, termination status (successful, cancelled…), and the resources 
(ink and paper) used to process it.

This information can be accessed from the printer’s front panel or from the Embedded Web Server, and it can be 
printed. There is also the capability of configuring the printer to send usage and accounting reports by email.

The usage, status, and accounting information can also be used by a third party application through a Software 
Development Kit provided by HP.

Get usage information 
Click  on the front panel to display the usage information.

The following information can be retrieved:

● Print categories usage: You can see the usage divided into categories.

NOTE: Depending on the contract you have with your support representative, print categories or paper 
types information may not be available or may be different.

– Mono lines: Black-and-white CAD jobs printed on standard paper

– Color lines: Color CAD jobs printed on standard paper

– Low density image: Between 10% and 50% of pixel coverage printed on standard paper
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– High density image: Over 50% of pixel coverage printed on standard paper

– Premium quality image: Any content type printed on premium paper

● Scan usage: The copy and scan usage in m², and the total amount.

● Ink usage: The ink consumed by each cartridge in ml, and the total amount of ink consumed.
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● Paper usage: Amount of paper used and the total at the top, divided into paper categories or families.

Usage can be seen at each level.

When you tap the Print usage report button, a message is displayed: The usage report was sent to the job queue 
and will be printed soon.

All the values can be displayed in English or metric units.

From the Embedded Web Server

The same information can be retrieved from the Embedded Web Server as from the front panel.

1. Access the Embedded Web Server, see Embedded Web Server on page 13.

2. Go to the Main tab.

3. Click History > Usage.

Print the usage information

There are two different ways to print the usage information from the front panel’s home screen:

● Tap  to launch the usage information screen, then tap the Print usage report button.

● Tap  , then Internal prints > Printer usage information > User information print > Print usage report.

Get detailed job accounting information
Accounting statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Embedded Web Server on page 13.

2. Go to the Main tab.

3. Under the History heading in the left-hand column, click Accounting.

Request usage and accounting data by email

1. Obtain the IP address of the outgoing mail server (SMTP) from your IT department; this is required in order 
to send email messages.

2. Ensure that the outgoing email server is configured to enable relaying of email messages that the printer 
will send.
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3. Open your Web browser and connect to the printer’s Embedded Web Server.

4. Click the Setup tab.

5. Under the Configuration heading in the left-hand column, click Date & Time.

6. Ensure that the printer's date and time have been set correctly.

7. In the Setup tab, under the Configuration heading in the left-hand column, click Email server.

8. Enter the IP address of the outgoing mail server (SMTP).

9. If the outgoing mail server is password-protected, enter the user name and password required to access it.

10. Specify an email address for the printer, which serves to identify the printer when it sends email messages. 
In most cases you are recommended to choose an email address already associated with the user name 
given in the previous step. See Turn usage information on and off on page 20.

11. In the Setup tab, under the Configuration heading, click Printer settings.

12. In the Accounting section, if you set Require account ID to On, then every time someone sends a print job to 
the printer, he or she must provide an account ID: for example, an ID corresponding to his or her 
department or to a specific project or client. If someone sends a job without providing an account ID, the 
printer will hold the unidentified job in the queue without printing it until an account ID is provided.

If you set Require account ID to Off, then the printer will print all jobs whether or not they have an account 
ID.

13. Set Send accounting files to Enabled.

14. Set Send accounting files to the email address (or addresses) to which you want the accounting information 
sent. This may be an address that you have created specifically to receive automatically generated 
messages from the printer.

15. Set Send accounting files every to the frequency with which you want the information sent, choosing a 
specific number of days or prints.

16. You may want to set Exclude personal information from accounting email to On, so that the accounting 
messages will not contain personal information. If this option is Off, information such as user name, job 
name, and account ID will be included.

17. In the Setup tab, under the Configuration heading, click Security. If you would like accounting messages to 
include the user name, check the Show user name in job accounting box. If this box is unchecked, the user 
name is not included.

When you have completed the above steps, the printer will send accounting data by email with the frequency 
that you specified. The data are provided in XML and can easily be interpreted by a third-party program. The data 
provided on each print job include when the job was submitted, when the job was printed, the printing time, the 
type of image, the number of pages, the number of copies, the paper type and size, the amount of each color of 
ink used and various other attributes of the job. Accounting data are also provided on scan and copy jobs.
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13 Printer specifications

● Functional specifications 

● Physical specifications 

● Memory specifications 

● Power specifications 

● Environmental specifications 

● Acoustic specifications 

● Speed specifications (Lines/Fast mode) 
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Functional specifications 

HP ink supplies

Printheads Eight CMYK printheads, each containing 25344 nozzles spaced at 1200 nozzles per inch

Ink cartridges Cartridges containing 775 ml of ink: black, cyan, magenta, yellow

Paper sizes

Minimum Maximum

Roll width 11 in (279 mm) 40 in (1016 mm)

Roll diameter 7 in (177 mm) *

Roll core diameter  3 in (76 mm)

Roll weight  18 kg (40 lb)

Sheet width (scanner) 36 in (914 mm)

Sheet length (scanner) Up to 15 m (49.21 ft), depending on file type

Roll paper thickness  0.4 mm (0.016 in)

Paper weight 70 g/m² 200 g/m²

* For rolls up to 36 in (914 mm)

Printing resolutions

Print quality Rendering resolution (ppi) Halftone resolution (dpi) Printing resolution (dpi)

Lines/Fast 600 × 600 600 × 600 1200 × 1200

Uniform areas 600 × 600 600 × 600 1200 × 1200

High detail 600 × 600 1200 × 1200 1200 × 1200

Scanner resolution: Up to 1200 ppi

Margins: 3 mm (0.012 in)  

Maximum printable width: 1000 mm (39.37 in)

Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F),  50-60% relative humidity, on E/A0 polypropylene in 
high-detail or uniform-areas mode.
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Graphic languages supported

Printer Languages

PostScript PostScript, PDF, TIFF, JPEG

Non-PostScript HP-GL/2, PCL 3 Win

Physical specifications 
Printer physical specifications

Width 1960 mm (77.17 in)

Depth 800 mm (31.5 in)

Depth with basket folded 991 mm (39 in)

Depth with basket unfolded 1266 mm (49.84 in)

Height with front panel 1527 mm (60.12 in)

Memory specifications   
Memory specifications

Physical DRAM 16 GB

Hard disk 500 GB

Solid-state disk 128 GB

Power specifications 
Printer power specifications

 Worldwide Asia-Pacific, Japan

Input voltage ~200–240 V ±10%

Two wires + PE

~200–240 V ±10%

Two wires + PE

Input frequency 50/60 Hz 50/60 Hz

Maximum load current 8 A 13 A

Power consumption (printing) 1.2 kW 2.2 kW

Power consumption (ready)   
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Environmental specifications 
Printhead environmental specifications

Storage temperature 5 to 40°C (41 to 104°F)

Storage humidity 20 to 80% RH, depending on paper type

Printer environmental specifications

Operating temperature 5 to 40°C (41 to 104°F)

Recommended operating temperature for best performance 15 to 35°C (59 to 95°F), depending on paper type

Storage temperature –25 to 55°C (–13 to 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity < 90% RH

Altitude 0 to 3000 m (10000 ft)

Acoustic specifications 
Printer acoustic specifications

Printing acoustic pressure ≤ 58 dB(A)

Printing acoustic power ≤ 7.4 B(A)

Ready acoustic pressure ≤ 36 dB(A)

Ready acoustic power ≤ 5.3 B(A)

Sleep acoustic pressure ≤ 16 dB(A)

Sleep acoustic power ≤ 3.4 B(A)

Speed specifications (Lines/Fast mode) 
30 D/A1 pages/min

142 Chapter 13   Printer specifications ENWW



14 Front-panel error messages 

The printer may occasionally display a system error, consisting of a numerical code of 12 digits followed by the 
recommended action that you should take.

In most cases you will be asked to restart the printer, because when the printer starts it can diagnose the issue 
better and may be able to fix it automatically. If the problem persists after restarting, you should contact your 
support representative and be ready to give the numerical code from the error message.

If the error message contains some other recommended action, follow the printer’s instructions.
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Glossary

Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network 
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area 
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited 
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same 
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a 
particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of 
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of 
the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the 
printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to 
minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the 
printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink cartridges). Additionally, to 
reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body 
movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Fast Ethernet
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable of 
negotiating slower speeds when required for compatibility with older Ethernet devices.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are 
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.
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Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with 
original USB. Most personal computers today use Hi-Speed USB.

HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes 
on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware 
whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated 
by full stops. Most networks in the world use IPv4 addresses.

IPv6 address
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of 
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the 
world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier 
than the IP address. Thus, a device may have both a MAC address and an IP address.

Network
A network is a set of connections that pass data between computers and devices. Every device is able to communicate with 
every other device in the same network. This allows data to be moved between computers and devices, and allows devices 
such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, 
dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.
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Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it 
on the paper, through a cluster of nozzles.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed USB 
(sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to your 
printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to 
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.
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